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Chapter 1

Introduction

This handbook is dedicated to the memory of Visicalc.

IMPORTANT
Please check http://docs.kde.org for updated versions of this document.

Calligra Sheets is a full featured spreadsheet program. It is part of the Calligra productivity suite
for KDE.

Other Calligra applications include Calligra Words, (word processing), Calligra Stage (slide pre-
sentation creator) among others.

You might care to visit http:/ /www.kde.org for more information about KDE in general, or the
Calligra web site at http://www.calligra.org
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Chapter 2

Calligra Sheets Basics

Pamela Robert

NOTE

Like the rest of KDE, Calligra Sheets is highly configurable, which can cause problems for readers
trying to compare the text in a document such as this with what they see on the version of Calligra
Sheets running on their desktop. To cut down on some of the possibilities for confusion, it is suggested
that when you first start to use Calligra Sheets you set the default options in all pages of the Calligra
Sheets configuration dialog (obtained by selecting Settings — Configure Sheets...).

2.1 Spreadsheets for Beginners

This section attempts to explain by example what a spreadsheet program such as Calligra Sheets
actually does, and why it is such a useful tool in any situation where you have to deal with
numbers. If you have already used a spreadsheet program you may wish to skip to the next
section.

The first thing to do is to start up Calligra Sheets. You can do this by left clicking on a Calligra
Sheets icon if there is one on your desktop or panel, or you can select Office — Calligra Sheets
from the application launcher.

Calligra Sheets

File Settings Help

General

Student ID Card
Business

D Blank Worksheet Blank Worksheet
General [ Always use this template

Student ID Card

Recent Documents

Y

P )

0)
10|

{7

0,

ia
9

Home and Family 2

D Blank Worksheet
Open Existing Document Use This Template
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When it has started you will be given the choice of opening a recent document, creating a new
document from a template (with templates categories) or opening an existing document . Select
the General category on the left and choose the Blank Worksheet template. Then click the Use
This Template button.

Looking at Calligra Sheets once it has started up, you will see a sheet of empty rectangular cells
arranged in numbered rows and lettered columns. This is where you enter data or formula, text
or charts.

Calligra Sheets

File Edit View Go Insert Format Data Tools Settings Help

[ New  [™] Open... Save ) Undo Change Value > Boeod >
A O cellEditor <]
87 a-vllnll. @ |=B2+B3+B4+BS
A B C [»] E

1 i
2 |Food 100 250

3 |Shelter 120 110

4 |Clothing 50 100

5 |Other 70 150

(4]

7 610

8

¢

M« |» v | Sheetl | Sheet2 Sheet3 -—

Sum: 340 100% ~

Now, enter the text and values shown in the first 5 rows of the above screenshot into the same
cells of your spreadsheet. Ignore what is in row 7 for the moment. To enter anything into a cell
first select the cell by left clicking inside it, then type whatever you want, then press Enter or use
the arrow keys to move the selection point to another cell.

What we have entered so far could be a simple budget for the next two months, listing how much
we think we will be spending for Food, Shelter, Clothing and any Other expenditure. Now select
cell B7 (column B, row 7), type in =B2+B3+B4+B5 and press Enter. Because it begins with a =
symbol Calligra Sheets sees this as a formula, something it has to calculate, in this case by adding
together the values in the 4 cells B2 to B5, and what is shown in the cell B7 is the result of that
calculation.

You could enter a similar formula into cell C7, except that in this case it would have to be =C2+
C3+C4+C5, but there is an easier way which is to Copy cell B7 and Paste it into C7. Calligra
Sheets will automatically adjust the cell references from B.. to C.. when the Paste is done.

At this point you may think that Calligra Sheets is doing no more than you could manage with
pencil, paper and a calculator, and you could be right, but remember that this is a very small
example of a spreadsheet, doing simple calculations on only a few numbers. For any reasonably
amount of values or data using a spreadsheet to do the calculations is much quicker and more
accurate than doing them manually.

Also, a spreadsheet lets you play the “What if?” game. Because each formula is automatically
recalculated whenever any of the values it refers to are changed, you can quickly see what hap-
pens if you alter any of them. Using our example you can see the effect of reducing the amount
spent on food in December by just entering a new value into cell C2. If you had a spreadsheet
that modelled the greenhouse effect accurately you could perhaps see the effect of a 50 percent
reduction in the amount of methane released into the atmosphere.

18



The Calligra Sheets Handbook

2.2 Selecting Cells

You can select a single cell or a rectangular area of cells in the spreadsheet. The selected cell(s)
are displayed with a thick black border.

YOU CAN SELECT A SINGLE CELL IN ONE OF THE FOLLOWING WAYS

e Jeft click on it

¢ enter the cell reference (for example B5) into the cell reference box at the left end of the Cell
Editor tool options and press Enter

¢ use the Go — Goto Cell... menu option

You can also steer your way around with the arrow keys. Pressing the Enter key will move the
current selection one position up, down, left or right depending on the setting in the Interface
page of Calligra Sheets’s configuration dialog box.

If you hold the Shift key down while using the arrow keys the selection will move to the start or
end of the block of occupied cells.

To select an area of contiguous cells drag the mouse cursor across the desired area with the left
button held down, or enter the references of the top left and bottom right cells separated by a
colon into the Cell Editor cell reference box (for example B7 : C14) and press Enter, or enter these
cell references in a similar format into the dialog box brought up by Go — Goto Cell....

You can also select an area of cells by selecting the cell in one corner of the wanted area then
holding the Shift key down while using the left mouse button to select the cell in the opposite
corner.

To select non-contiguous cells, click on the first cell you want to select then hold the Ctrl key and
select the other cells.

To select a complete row or column of cells left click on the row number at the left of the work-
sheet or on the column letters at the top. To select adjacent rows or columns drag the mouse
pointer over the appropriate row numbers or column letters with the left button held down.

To select non-contiguous rows or columns of cells, click on the first row number or column letter
then hold the Ctrl key and select the other rows or columns of cells.

2.3 Entering Data

Entering data into a cell can be as simple as selecting the cell, typing your data, then pressing
Enter or moving the selection to another cell with one of the arrow keys. Depending on how you
enter the data, Calligra Sheets will interpret it as a number, date, time or text:

* Numbers are entered in the obvious way; 123, -123, 456. 7 or in scientific notation -1 . 2E-5.

¢ Dates should be entered in your ‘System’ format, as defined in the System Settings in Locale —
Country/Region & Language — Date & Time tab. If, for example, you are using the DD/M-
M/YYYY form you should enter 30/03/2012 for 30th March 2012. Leading zeroes can be
omitted from the day and month fields and only the last one or two digits of the year need to
be entered if the date is in the current century, for example 9/1/9 for 9th January 2009.

¢ Times should also be entered using the ‘System’ format. For example if you are using a 12 hour
clock then enter times in HH:MIN am | pm or HH:MIN:SS am | pm format such as 9: 42 amor
10:30:52 pm.

¢ Calligra Sheets defines any input data as “text” if it cannot recognize the data as being a number,
date or time.
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NOTE

By default, Calligra Sheets right justifies numbers, dates and times within a cell and left justifies any-
thing else. This can be a useful guide to whether you have entered a date or time in the correct format.
But remember that how items are displayed can be changed by altering the cell format.

The main text entry box in the Cell Editor tool options provides an easy way of editing the
contents of a selected cell. Press Enter or left click on the green tick mark when you are happy
with what you have entered, or click on the red cross to cancel your edits.

2.3.1 Generic Cell Format

Calligra Sheets uses the ‘Generic’ cell format as default. As long as this format is used, Calligra
Sheets autodetects the actual data type depending on the current cell data. For example if you
enter some text into a cell and later enter a number into the same cell, Calligra Sheets automat-
ically interprets the new data as a number. If you want to define the type of data yourself, you
can explicitly set it in the cell format. You can change the format back to ‘Generic’ at any time.

24 Copy, Cut and Paste

At first glance, Calligra Sheets’s Cut, Copy and Paste appear to be similar to these functions in
other KDE applications. Having selected a cell or cells, you can choose Copy or Cut from the
Edit menu or from the drop down menu you get by holding the right mouse button down on
a selected cell. You can also use the shortcuts Ctrl+C or Ctrl+X, then move the selection to the
target cell and choose Paste or press Ctrl+V. However there are some subtleties associated with
these functions in Calligra Sheets and these are discussed below.

If a cell contains a formula then the formula itself is copied rather than the displayed result, and
if the formula contains a reference to another cell, then that reference is changed by the Cut or
Copy and Paste operation to point to the cell that is in the same relative position as in the original
cell. For example if cell A2 contains the formula =B3 and is copied to C4, cell C4 will contain =D5

This may seem to be a rather strange way of doing a copy, but 99 percent of the time it is exactly
what is wanted (if it is not then see the section about absolute cell references). For example in the
simple shopping list shown below, cell D2 should contain =B2 * €2, D3 should be =B3 * C3,
D4 should be =B4 * C4 and so on. Instead of having to enter a different formula in each cell,
you can just enter the first formula into D2 and then copy it into the cells below, letting Calligra
Sheets adjust the cell references to suit.
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Calligra Sheets

File Edit View Go Insert Format Data Tools Settings Help

[} New [P] Open... Save ) Undo Autofill > BoBod >
A 5 cellEditor o @

e @A~ | f| v O

A B C D E '

1 |Item Price per unit |Quantity Total

2 |Apples(kg) 2.25 1 2.25

3 |Bread(loaf) 0.65 1 0.65

4 |Milk(ltr) 0.92 2 1.84

5 |Cat Food (tin) 0.38 5 1.9

6

7

8
BN —1

10
11
12

W 4 » v | sheett [ sheet2 [ Sheets / =m

Sum: 0 100% v em—

241 Copying and Pasting Cell Areas

In the above example D2 can be copied into all three cells D3 to D5 at once by just copying D2
then selecting the complete cell area D3:D5 before doing the paste.

A rectangular area of cells can be cut or copied in one operation by selecting the area before doing
the cut or copy. Then select the top left corner cell of the area you want to paste into before doing
the paste.

If you cut or copy a rectangular area of cells, say B2:C3, and paste it into a larger area such as
A10:D13 the original pattern of cells will be repeated to fill the target area.

Calligra Sheets also provides a ‘Drag and Copy’ method for copying cells down into other cells
immediately below or to the right of the original cell(s). To use this method select the cell(s) to
be copied then position the mouse pointer over the small black square at the bottom right corner
of the selected cell(s) so the cursor changes to a double headed arrow. Then hold the left mouse
button down while you drag the selected cell(s) as far as you wish. Note that cell references in
formulae are incremented according to the relative position change. Absolute references are not
changed.

2.4.2 Other Paste Modes

A cell may contain text, a value, or a formula, and may also contain special font, border or back-
ground formatting information. Calligra Sheets has special versions of Paste that let you handle
these items in different ways.

Edit — Special Paste...brings up the Special Paste dialog box. By selecting the appropriate item
from the left part of this dialog you can choose to paste Everything, just Text, the cell Format, any
Comment in the cell(s) or Everything without border. The items in the right part of this dialog
box allow you to do simple arithmetic on an area of cells.

Paste with Insertion... inserts the copied cell(s) into the sheet by moving the cells that would
otherwise be overwritten a suitable number of rows of columns down or to the right. It can also
be used to insert complete copied row(s) or column(s) into the worksheet.
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2.5 Insert and Delete

Use the Del key or Edit — Clear — Contents to remove the text, value or formula from selected
cell(s), row(s) or column(s) without affecting anything else.

To delete everything in the selected cell(s), row(s) or column(s), including comments and special
formatting, choose the All option from the Edit — Clear menu or from the pop up menu you get
when you right click on a selection.

To remove selected row(s) or column(s) completely, use the Delete Rows or Delete Columns
options from the right mouse button pop up menu.

If you select a cell or cells and choose Remove Cells... from the right mouse button pop up
menu, you can then choose whether other cells in the worksheet will be moved up or to the left
to fill in the space left by the cell(s) you have chosen to remove.

If you want to insert new, blank, row(s) or column(s) into the sheet, select row(s) or column(s)
where you wish the new row(s) or column(s) to be placed and choose the Insert Rows, Insert
Columns option from the right mouse button pop up menu.

You can insert new cells into the worksheet by selecting the area where you want them to appear
then choosing the Insert Cells... option from the right mouse button pop up menu. You will
then be asked whether the existing cell(s) in the selected area should be moved down or to the
right to make room for the new ones.

2.6 Simple Sums

If the first character in a cell is an equals sign (=) Calligra Sheets will take the cell contents to be a
formula which is to be calculated. The result of the calculation will be displayed in the cell rather
than the formula itself. For example, enter =2+3 into a cell and it should display 5.

More usefully, a formula can contain references to other cells, so that =B4+A3 will calculate the
sum of the values in cells B4 and A3, and this calculation will be updated whenever cells B4 or
A3 are changed.

As well as addition, a formula can make use of the - symbol for subtraction, * for multiplication,
and / to perform division. The round bracket symbols ( and ) can also be used as in normal
algebra, so you could enter more complex formulae such as =((B10 + C3) %5 — F11) / 2

Cells containing a formula will be marked with a small blue triangle at the bottom left corner
if the Show formula indicator check box in the Format — Sheet — Sheet Properties dialog is
checked.

Calligra Sheets also includes a large number of built-in functions for applications such as statis-
tical, trigonometrical and financial calculations. Their use will be examined in more depth in a
later section of this manual, but if you are interested at this stage choose Function... from the
Insert menu and take a look through the Function dialog box that will be displayed.

For the time being, however, the SUM function may be of interest as it calculates the sum of all
values in a specified area of cells. For example =SUM (B4 :C10) calculates the sum of all values
in the cell area B4 to C10.

If Calligra Sheets displays #VALUE! when you have entered your formula this usually means
that it cannot understand what you have entered, but if the row of symbols ends with a small red
arrow this just means that the cell is not wide enough to display the complete result, in which
case you should either make the cell(s) wider or change their format so that the result does fit

properly.
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2.6.1 Recalculation

If the Automatic recalculation box in the Format — Sheet — Sheet Properties dialog box is
checked, Calligra Sheets will recalculate the values of cells whenever anything that affects them
is changed in the sheet.

When Automatic recalculation is not checked for the current sheet, you can instruct Calligra
Sheets to perform a recalculation at any time by using the Recalculate Sheet or Recalculate
Document option in the Tools menu or their shortcuts Shift+F9 or F9.

2.7 Sorting Data

In the simple example shown below, the data consist of the names and countries of a number of
mountains together with their height above sea level. Calligra Sheets can sort data such as this
in different ways.

Calligra Sheets

File Edit View Go Insert Format Data »
A & cellEditor o ]
o 4av|&|lv | ®
1465
A B C l

1 |Mountain Country Height (meters)

2 |McKinley United States 6194

3 |Roosevelt Canada 2972

4 |Kilimanjaro  Tanzania 5895

5 |Waddington |Canada 4042

6 |Ewverest Nepal 8848

7 Puyde Dome [France

8

9

10

M 4 r v | Sheetl | Sheet2 Sheet3 -

Sum: 1465 100% v

We may want the data sorted so that the names are in alphabetical order. To do this select the
area containing the data (A2:C7 in this case) and choose Sort... from the Data menu. This opens
the Sort dialog box.

Sorting is done alphanumerically, and the default is case sensitive, numbers coming before up-
percase letters which come before lowercase letters, so that cells containing the entries Cat, bar,
77 and Bat would be sorted into the following order: 77 Bat Cat bar.

In the Direction area of this dialog box select to sort in rows or columns. If you check the First

row contains column headers or First column contains row headers box data in the first row or
column will not be included in the sort operation.

The rows or columns are sorted in the specified order, which can be changed using the Move Up
and Move Down buttons. Using the example in the above screenshot, choosing column B as the
first key and column C as the second would sort the data by country and, for each country, by
height.

Uncheck the option Case Sensitive to get a sort not depending on capitalization and switch the
sort order between Ascending and Descending by clicking on the cells in the column Sort Order.
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The Details » extension of the dialog allows you to sort using the order of items in a custom list
such as January, February... instead of alphanumerically. The cell format is moved with the cell
content, if you select Copy cell formatting (Borders, Colors, Text Style).

2.8 The Status bar Summary Calculator

The left hand end of the Status bar by default shows a summary of the values in the selected
cell(s). According to the setting of the Function shown in status bar combo box in the Interface
page of Calligra Sheets’s configuration dialog the summary can be:

None
No summary calculation is performed.
Average
The value displayed is the average of the values in the selected cells.

Count
The value displayed is the number of cells containing numeric values.

CountA
The value displayed is the number of non empty cells.

Max

The value displayed is the maximum of the values in the selected cells.
Min

The value displayed is the minimum of the values in the selected cells.

Sum
The value displayed is the sum of the values in the selected cells.

The method of calculation can also be changed by right clicking on the summary calculation
result area of the Status bar and choosing an item from the pop up menu.

2.9 Saving your Work

Calligra Sheets saves the complete document, which may include more than one worksheet, as a
single document file.

If you have created a new document, or want to save an existing one under a different name, use
File — Save As.... This will bring up KDE’s common Save Document As dialog box. Choose
the folder where you want to save the document and enter a suitable file name into the Name
text box. Calligra Sheets documents are normally automatically saved with a .ods extension,
you do not need to add this to the filename but do make sure that the Filter selection is set to
OpenDocument SpreadSheet.

To save your document without changing its name, just use File — Save.

You can also save a Calligra Sheets document in a foreign format selecting the format from the
Filter: combo box.

When you save a modified version of an existing document Calligra Sheets will keep the previous
version as a backup file, adding a . to the end of the filename.

Calligra Sheets can provide some protection against losing your work because of a computer
crash or because you have closed Calligra Sheets without saving the current document. It does
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this by automatically saving the latest version of the document you are working on every few
minutes using a modified file name. The autosaved version is normally removed when you
next save your document, so that it will only exist if it is more up to date than the version that
was saved manually. When you open a document Calligra Sheets checks to see if an autosaved
version exists, and if it finds one it will offer to open that instead.

Autosaved documents are saved with a file name of the form .yourfilename.autosave (note
the leading period), so that spreadl.ods would be autosaved as .spreadl.ods.autosave. The
autosave feature is user configurable in the settings dialog.

2.9.1 Templates

If you are going to be creating a lot of similar documents you can save yourself time and trouble
by first creating a template and then using that as the basis for the individual documents.

To do this first create a document containing the common elements, then save it as a template
by choosing File — Create Template From Document. Doing this opens the Create Template
dialog box. Enter a name for your new template into the Name: text box and press OK. The next
time you start a new document by choosing File — New or when you next start Calligra Sheets
the startup dialog window will give you the option of creating the new document from your
template.

The Create Template dialog box also lets you choose a different picture to be displayed above the
template name in the startup dialog window, and lets you save your templates under different
group names, which will appear as different pages in the dialog.

Templates are stored as . kst files under ../.kde/share/apps/tables/templates/ .

210 Printing a Spreadsheet

Printing a spreadsheet is basically done by selecting File — Print... which brings up KDE’s com-
mon Print dialog box where you can choose, among other options, the printer to be used, the
number of copies and whether all or only selected pages are to be printed.

By default Calligra Sheets will print all items in the current worksheet, but you can restrict this
by first selecting the area that you want to be printed then choosing Define Print Range from the
Format — Print Range sub menu.

Calligra Sheets will print as many pages as are necessary to include all items in the current work-
sheet. You can quickly see how a worksheet will be split into separate pages for printing by check-
ing the View — Page Borders box. The boundaries of each printed page will then be marked by
colored lines in the worksheet.

For a more detailed view of what is to be sent to the printer, including anything you have asked
to be included in the page headers and footers (see below), choose File — Print Preview....

To improve the appearance of the printed output , you can change the fonts, colors, borders and
sizes of the cells in the worksheet, see the Spreadsheet Formatting section for more details about
how to do this.

You can also use the Page Layout dialog box, invoked by selecting Format — Page Layout...,
to change the orientation of the printed pages, the paper size (this should be suitable for your
printer) and the size of the page borders.

The Sheet provides more options. The Print settings section lets you select whether or not to
print the grid, comment indicators and formula indicators, objects and charts. The Repetitions
on each page section allows you to repeat selected column(s) or row(s) on each printed page. In
the section Scaling you can set a scalefactor or the page limits for the print.
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Chapter 3

Spreadsheet Formatting

Pamela Robert
Raphael Langerhorst

Anne-Marie Mahfouf

3.1 Cell Format

To change the format and appearance of selected cell(s), row(s) or column(s) use the Cell Format...
option from the Format menu or from the right mouse button popup menu.

L]

Cut Ctri+X

| = - .

2

]

Copy Ctri+C

Paste Ctrl+v

oo

Special Paste...

£

Paste with Insertion

=

All
Adjust Row & Column
Default

Area Name...

EH Insert Cells...
B Delete Cells...

—H Comment

This will bring up the Cell Format dialog box which has several tabbed pages:
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3.1.1 Data Formats and Representation

Cell Format — Calligra Sheets

Data Format Font Position Border Background = Cell Protection
Format
Generic
() Number
{ ) Percent
[ ) Money
(") Scientific
: ) Fraction
() Date
{ ) Time
() Date and Time Preview
() Text
Prefix: Format: | 123456  -123.456 ~
Precision: | 0 s
Postfix:
+ OK ® Cancel

The Data Format page of the Cell Format dialog box lets you control how the values of cells are
displayed.

The top part of this page lets you select the format to be used when displaying numeric values,
dates or times. A Preview pane allows you to see the effect of the new format.

You can set the same data format for a row or a column by selecting the row or column and
calling the Cell Format dialog with the right mouse button.

NOTE

You can increase the precision decimal for any number in Generic, Number, Percent, Money or
+00

Scientific formats using the Increase precision icon in the Format toolbar:

You can decrease the precision decimal for any number in Generic, Number, Percent, Money or

+1
Scientific formats using the Decrease precision icon in the Format toolbar:

Generic

This is the default format and Calligra Sheets autodetects the actual data type depending
on the current cell data. By default, Calligra Sheets right justifies numbers, dates and times
within a cell and left justifies anything else.

If the Generic format does not suit you, you can change to a specific format among the
choices below.

Number

The number notation uses the notation you globally choose in System Settings in Locale
— Country/Region & Language — Numbers. Numbers are right justified by default.
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Percent

When you have a number in the current cell and you switch the cell format from Generic
to Percent, the current cell number will be multiplied by 100.

For example if you enter 2 and set the cell format to Percent, the number will then be 200
%. Switching back to Generic cell format will bring it back to 2.

Yo

You can also use the Percent icon in the Format Toolbar:

Money

The Money format converts your number into money notation using the settings globally
fixed in System Settings in Locale — Country/Region & Language — Money. The currency
symbol will be displayed and the precision will be the one set in System Settings.

You can also use the Money Format icon in the Format toolbar to set the cell formatting to

look like your current currency: &'

Scientific

The Scientific format changes your number using the scientific notation. For example,
0.0012 will be changed to 1.2E-03. Going back using Generic cell format will display 0.0012
again. The Generic cell data format does not keep scientific notation so if you want this
notation, you have to specify it using this menu item.

Fraction

Date

Time

The Fraction format changes your number into a fraction. For example, 0.1 can be changed
to 1/8, 2/16, 1/10, etc. You define the type of fraction by choosing it in the field on the
right. If the exact fraction is not possible in the fraction mode you choose, the nearest
closest match is chosen. For example: when we have 1.5 as number, we choose Fraction
and Sixteenths 1/16 the text displayed into cell is "1 8/16” which is an exact fraction. If you
have 1.4 as number in your cell and you choose Fraction and Sixteenths 1/16 then the cell
will display “1 6/16" which is the nearest closest Sixteenth fraction.

To enter a date, you should enter it in one of the formats set in System Settings in Locale
— Country/Region & Language — Date & Time. There are two formats set here: the date
format and the short date format.

A random natural number NN will be transformed in the date from 30st December 1899
(which is 0) with the number of days NN added. For example if you have a cell with 100
and you choose Date format, “1900-04-09” will be displayed in the cell which is 100 days
after 30st December 1899. This starting date is two days early as it was a bug in Lotus 123
and then it stayed that way in Excel in order to keep compatibility. Few people will need
to calculate from 1st January 1900 anyway and adding 9 days to 1st November 2000 for
example will give you 10th November 2000 so all normal calculations on dates are correct.

NOTE
When a cell is in the Date format, you can drag this cell down as you do with numbers and the
next cells will also get dates, each date being increased by one day.

This formats your cell content as a time. To enter a time, you should enter it in the Time
format set in System Settings in Locale — Country/Region & Language — Date & Time. In
the Cell Format dialog box you can set how the time should be displayed by choosing one
of the available time format options. The default format is the system format set in System
Settings. When the number in the cell does not make sense as a time, Calligra Sheets will
display 00:00 in the global format you have in System Settings.
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and Time

This formats your cell content as date and time. To enter a date and a time, you should
enter it in the Time format set in System Settings in Locale — Country/Region & Language
— Date & Time. In the Cell Format dialog box you can set how the date and time should
be displayed by choosing one of the available date and time format options. The default
format is the system format set in System Settings. When the number in the cell does not
make sense as a date and time, Calligra Sheets will display 00:00 in the global format you
have in System Settings.

This formats your cell content as text. This can be useful if you want a number treated as
text instead as a number, for example for a ZIP code. Setting a number as text format will
left justify it. When numbers are formatted as text, they cannot be used in calculations or
formulas. It also change the way the cell is justified.

Custom

Does not work yet. To be enabled in the next release.

The lower part of the Data Format page lets you add a Prefix: such as a $ symbol at the start
of each item or a Postfix: such as $HK to the end. You can also control how many digits are
displayed after the decimal point for numeric values, whether positive values are displayed with
a leading + sign and whether negative values are shown in red.

3.1.2 Fonts and Text Settings

Cell Format — Calligra Sheets

Data Format Font Position Border Background = Cell Protection
Nimbus Mono PS Style: Roman =7
Nimbus Roman
Nimbus Sans I SR 1o L
Nimbus Sans Narrow Weight: Normal v
Noto Kufi Arabic
Nota Music coor |
Noto Naskh Arabic [] underline
Noto Naskh Arabic Ul (] strike out

Noto Nastaliq Urdu

Noto Sans

Noto Sans Adlam

Noto Sans Adlam Unjoined

Noto Sans Anatolian Hieroglyphs

Noto Sans Arabic

Preview

Dolor Ipse

~ OK ® Cancel

The Font page lets you select the font family, Style:, Size:, Weight: and Color: for the current
cell, including some additional options like underlined or striked out text. The lower part of the
page gives a Preview of the selected text format.

The default font is set for all cells in the Format — Style Manager menu with the currently used

style.
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Style:

Choose the style for your font for the currently selected cells. When you select several cells
with different styles, the displayed style is set to Varying (No Change) and leaving it that
way will keep all your current style settings for each cell. Changing to Roman for example
will change all the selected cells style text to Roman.

Size:
Choose the size for your font for the currently selected cells. When you select several cells
with different sizes, the displayed size is set to (no number written) and leaving it that
way will keep all your current size settings for each cell. Changing to 14 for example will
change all the selected cells font size to 14.

Weight:

Choose the weight for your font for the currently selected cells. When you select several
cells with different font weight, the displayed weight is set to Varying (No Change) and
leaving it that way will keep all your current weight settings for each cell. Changing to
Bold for example will change all the selected cells font weight to Bold.

Color:

Choose the color for the currently selected cells” text. Clicking on the color bar will bring
you the standard KDE Select Color dialog where you will be able to choose the new color.

Underline
Underlines the currently selected cells’ text if checked. This is not checked per default.

Strike out

This will strike out the currently selected cells’ text if this is checked. This is not checked
per default.

3.1.3 Text Position and Rotation

Cell Format — Calligra Sheets

Data Format Font Position Border Background = Cell Protection
Horizontal Vertical
O Left () Top
Standard Center () Middle
() Right () Bottom
Text Option Rotation
[] wrap text
[ vertical text 0°
[ shrink to fit
Merge Cells Indent
0,00mm 7
Size of Cell
Width: 2469 mm Height: 4,94mm
(] Default width (24.6944 mm) [] Default height (4.9388 mm)
+ OK ® Cancel

From the Position page you can control the position of text within a cell by making suitable
selections in the Horizontal and Vertical areas or by setting the Indent value. You can also
choose to have the text appear vertically rather than horizontally, or even at an angle.
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Horizontal

Set the content position horizontally in the cell. Standard is default and is set from the data
format you choose. Left means the content will be displayed on the left of the cell. Center
means the content will be in the center horizontally in the cell. Right means the content of
the cell will be displayed on the right of the cell.

Vertical
Set the content position vertically in the cell. Top means the content will be displayed on
top of the cell. Middle means the content will be in the middle vertically in the cell. Bottom
means the content of the cell will be displayed at the bottom of the cell.

Text Option

This is only available when the rotation is 0. Wrap text wraps the text so it fits in the
previous cell size. If this is not checked, the text will stay on one line.

Vertical text puts your text vertically.

Rotation
Your text will appear oriented in the angle you set here. Positive values will move it
counter-clockwise and negative values will move it clockwise.

Merge Cells

When checked, this has the same effect as Format — Merge Cells. You need to have at least
two consecutive cells selected. Those consecutive cells are then merged into a bigger one.

When a merged cell is selected and when you uncheck this, then all cells come back to their
original size as before the merging. It has the same effect as Format — Dissociate Cells.
Indent

Set the amount of indent that will be used in the cell when you choose the Increase In-
dent/Decrease Indent actions from the toolbar. These actions are not enabled by default in
the toolbar.

Size of Cell

You set here the size of the cell, either a custom width and height or choose the default
width and height.
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3.1.4 Cell Border

Cell Format — Calligra Sheets

Data Format Font Position Border Background = Cell Protection

Border Pattern

z z |

D Customize
Preselect
....... a
Color:
& = & Preview
~ OK ® Cancel

The Border page lets you set the appearance of the cell borders. If you have selected more than
one cell you can apply different styles to the borders between the cells and that surrounding the
selected area.

First select the pattern and color from the Pattern section of the Border page then apply that to
different parts of the border by clicking on the appropriate button in the Border section, or on one
of the Preselect buttons. The left hand button in the Preselect section will clear any previously
applied border(s). Note that you can also add a diagonal strike-through line to the cell(s).
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3.1.5 Cell Background

Cell Format — Calligra Sheets

Data Format Font Position Border Background | Cell Protection

Pattern

b

No Color

Background color:

Preview

+ OK ® Cancel

The cell background pattern and color can be selected from the Background page.
Simply choose a desired Pattern, then select the pattern Color and the Background color.

At the bottom of this page you can see a Preview of the configured cell background.

3.1.6 Cell Protection

Cell Format — Calligra Sheets

Data Format Font Position Border Background | Cell Protection

Protection
[ Hide an
Protected
[_] Hide formula
Printing

\:| Do not print text

0K ® Cancel
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You can change the way the content of a cell is protected in the Cell Protection page.

All cells are protected by default (that means cell content cannot be changed) and for the cell
protection to be active you also need to protect the sheet using the Tools — Protect Sheet... menu
and to provide a password. You can also hide the cell formula in order to protect the way you
calculate the formula. This also needs to enable sheet protection to work. You can hide the cell
content with Hide all and again this needs sheet protection. You can learn more about all these
settings in the Advanced Calligra Sheets chapter, Protection section.

Hide all

This hides the cell content and works only when the sheet is protected which means that
changing the Hide all attribute of a cell has no effect unless the sheet is protected. Whether
the cell itself is protected or not does not matter.

When Hide all is selected, Protected and Hide formula are disabled as when the sheet is
protected Hide all hides the cell content and the formula and thus masks and protects the
cell content.

Protected

If checked, the cell content will be protected. This is the default behaviour. You need to
protect the whole sheet using the Tools — Protect Sheet... menu for this individual cell
protection to work. When a cell is protected, its content cannot be changed.

Hide formula

When this is checked, the cell is still visible. However, its contents do not appear in the
Formula bar. Hiding formula is only working for cells that contain formulae so the user
cannot view the formula. And the sheet must be protected for this to work.

Do not print text

If you check Do not print text then the text in the cell will not be printed. This is unchecked
per default which means that the cell text will always be printed by default.

3.2 Conditional Cell Attributes

You can make the appearance of a cell change according to the value it contains, useful perhaps
if you are using Calligra Sheets to keep track of your household expenses and want to highlight
any item greater than, say, one thousand dollars.

To do this select the cell(s) then choose Conditional Styles... from the Format menu. This will
bring up the Conditional Styles dialog box where you can make the font type and color of a cell
change when the value meets one or more conditions. Note that the second and third conditions
only apply if the previous condition(s) are not met.

Use Clear — Conditional Styles from the Edit menu to clear any conditional attributes from
selected cells.

3.3 Changing Cell Sizes

The Position page in the Cell Format dialog lets you alter the size of the selected cell(s). Note
that changing the height of a single cell will change the height for all cells in that row, similarly
changing the width will affect the entire column.

You can also select the row(s) or column(s) to be changed then select Resize Row... or Resize
Column... from the right mouse button pop up menu or from the Format — Row or Format —
Column menu.
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If you move the mouse cursor so that its tip is over the line between two of the row numbers at
the left of Calligra Sheets’s window the cursor will change to show two parallel lines each with
a short arrow headed line coming from it. When the cursor is in this state you can hold the left
mouse button down and drag the border between the two rows, changing the height of the upper
row. A similar technique can be used to change the width of a column.

To set the row height or column width to the minimum needed to display the contents, select the
whole row or column, and click with the right mouse button on the row or column label. In the
menu which appears, select Adjust Row or Adjust Column. The row or column will resize to
the minimum necessary. You can also select a single cell or range of cells, and click Adjust Row
& Column from either the right mouse button popup menu or the Format menu.

You can make a number of adjacent rows or columns the same size by selecting them then choos-
ing Format -+ Row — Equalize Row or Format — Column — Equalize Column.

3.4 Merging Cells

It is often convenient to have one cell that spreads across two or more columns or down more
than one row. This can be done by merging two or more cells into one. Select the cells to be
merged than choose Format — Merge Cells.

To reverse this process, select the merged cell then choose Dissociate Cells from the Format
menu.

3.5 Hiding Rows and Columns

A finished spreadsheet can often be made to look more attractive by hiding the cells containing
intermediate calculations so that only the important data input and result areas are shown.

In Calligra Sheets you can hide selected rows or columns by using the Hide Rows and Hide
Columns options from the Format — Row, Format — Column or right mouse button menus.
Hidden rows and columns are not displayed on the screen or included in a print out.

Hiding cells in this way also makes them slightly less prone to accidental change.

To un-hide a row or column select Row — Show Rows... or Column — Show Columns... from
the Format menu. In the dialog box which appears, you can select any number of rows to show.

3.6 Sheet properties

You can access the current sheet properties either by right clicking on the sheet tab and choosing
Sheet Properties or by using the Format — Sheet — Sheet Properties menu. Please note that you
can only access the Sheet Properties when the document or the sheet is not protected.

You can set different properties that will be valid in the current sheet. Clicking on OK will
validate your changes and Defaults will bring back the default settings.
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Sheet Properties - Calligra Sheets

Layout direction: | Left to Right

[ ] Hide zero (M| Show grid

(W] Automatic recalculation [ ] show page outline

[ ] show column as numbers (] show formula

[ ] Use LC mode (] show formula indicator

[ ] Convert first letter to uppercase (M| Show comment indicator

[ Defaults « OK = Cancel

Layout direction:

Let you choose the sheet orientation. Default is that the first column of the sheet is on the
left. If you choose Right to Left, then the first column will be on the right and the others
added from right to left.

Hide zero
If this box is checked any cell containing the value zero will appear blank.

Automatic recalculation
This setting controls whether formulae are recalculated automatically when the value of
any cell they refer to changes.

Show column as numbers

If this box is checked the column headings will show as numbers rather than as letters.
Letters are default.

Use LC mode

If this box is checked the cell reference shown at the left end of the Formula Bar will be
displayed in LC mode (i.e. L2C3) rather than in its normal form B3. This does not seem to

be of much use at the moment.
Convert first letter to uppercase

Check this box and the first letter of any text you type in will automatically be converted to
uppercase.

Show grid

If checked the grid (the cell limits) will be shown. This is default. If you uncheck it, the grid
will be hidden.

Show page borders

If you check this option, the page borders will be drawn on your current sheet. Per default
the page borders are not displayed. It is useful to see the page borders if you want to print
your sheet.
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Show formula
If this box is checked Calligra Sheets will display the actual formulae in cells rather than
the results.

Show formula indicator

If this box is checked Calligra Sheets will display a small blue triangle at the bottom left
corner of cells containing formulae. This is useful if you want to protect cells with formulae.

Show comment indicator

If this box is checked cells containing comments will be marked by a small red triangle at
the top right corner.
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Chapter 4

Advanced Calligra Sheets

Pamela Robert
Anne-Marie Mahfouf

4.1 Series

When constructing a spreadsheet you often need to include a series of values, such as 10, 11, 12...,
in a row or column. There are several ways you can do this in Calligra Sheets.

For a simple short series such as 5, 6, 7, 8... the ‘Drag and Copy " method is the simplest. Enter
the starting value into the starting cell and the next value of the series into an adjacent cell. Then
select both cells and move the mouse pointer so that it is over the small square at the bottom
right corner; the cursor will change to a diagonal double headed arrow. Then hold the left mouse
button down while you drag the cells down or across as needed.

The step size is calculated as the difference between the two starting values that you have entered.
For example if you enter 4 into cell A1 and 3. 5 into A2 then select both cells and Drag and Copy
them down, the step size will be the value in A2 minus the value in Al, -0.5 in this case so you
will get the series 4, 3.5, 3, 2.5, 2...

The ‘Drag and Copy’ method will even cope with series where the step value is not a constant
value but is itself a series. So that if you start with 1, 3, 4, 6 Drag and Copy will extend it to 1, 3,
4,6,7,9,10, 12.., the step value in this example being the series 2, 1,2, 1...

Calligra Sheets also recognizes some special ‘series’ such as the days of the week. Try entering
Friday into a cell (note the capitalization) then Drag and Copy it down. To see what special
series are available, and perhaps create your own, select Tools — Custom Lists...

If you select a cell and choose Series... from the Insert menu you will see the Series dialog box.
This is useful for creating series that are too long to be conveniently constructed using the Drag
and Copy method, or for creating geometric series such as 1, 1.5, 2.25, 3.375... where the step
value, 1.5 in this case, is used as a multiplier.

If the type of series that you want is too complicated for any of the previous methods, consider
using a formula and Drag and Copying that. For example to create a series with the values 2, 4,
16, 256... enter 2 into Al, =A1*A1 into A2, and Drag and Copy cell A2 down.

4.2 Formulae

4.2.1 Built in Functions

Calligra Sheets has a huge range of built in mathematical and other functions that can be used in
a formula cell. They can be seen and accessed by selecting a cell then choosing Function... from

38



The Calligra Sheets Handbook

the Insert menu. This brings up the Function dialog box.

Select the function you want to use from the listbox at the left of the dialog box. The Help tab
page will then display a description, the return type, Syntax, Parameters, and Examples for this
function. In addition this page provides often links to Related Functions. Then press the button
with the down arrow key symbol on it to paste it into the text edit box at the bottom of the dialog.

The Parameters tab page will then be displayed to let you enter the parameter(s) for the function
you have just chosen. If you want to enter an actual value for a parameter, just type it into the
appropriate text box in the Parameters page. To enter a cell reference rather than a value, left
click on the appropriate text box in the Parameters page; then left click on the target cell in the
spreadsheet.

Instead of using the Parameters page, cell references such as B6 can be entered by typing them
directly into the edit box at the bottom of the Function dialog. If a function has more than one
parameter separate them with a semi-colon ;).

Pressing the OK button will insert the function into the current cell and close the Function dialog.

You can of course do without the Function dialog and simply type the complete expression into
the main text entry box in the Cell Editor tool options. Function names are not case sensitive. Do
not forget that all expressions must start with an = symbol.

4.2.2 Logical Comparisons

Logical functions such as IF(), AND(), OR() take parameters which have the logical (boolean)
values True or False. This type of value can be produced by other logical functions such as
ISEVEN() or by the comparison of values in spreadsheet cells using the comparison expressions
given in the following table.

Expression Description Example

A2==B3 is True if the value
== Is equal to in A2 is equal to the value in
B3

A2!=B3is True if the value
I= Is not equal to in A2 is not equal to the
value in B3

<> Is not equal to Same as A2 !=B3

A2<B3 is True if the value

< Is less than in A2 is less than the value
in B3

A2<=B3is True if the value
<= Is less than or equal to in A2 is less than or equal to
the value in B3

A2>B3 is True if the value

> Is greater than in A2 is greater than the
value in B3

A2>=B3 is True if the value
>= Is greater than or equal to A2 is greater than or equal
to the value in B3

Thus if you enter =IF (B3>B1; “BIGGER"; ) into a cell it will display BIGGER if the value in
B3 is greater than that in B1, otherwise the cell will show nothing.

39



The Calligra Sheets Handbook

4.2.3 Absolute Cell References

If a formula contains a cell reference that reference will normally be changed when the cell is
copied to another part of the worksheet. To prevent this behavior put a $ symbol before the
column letter, row number or both.

¢ If Al contains the formula =D5 then on copying the cell to B2 it will become =E6 (the normal
behavior).

¢ If Al contains the formula =$D5 then on copying the cell to B2 it will become =D6 (column
letter not changed).

¢ If Al contains the formula =D$5 then on copying the cell to B2 it will become =E5 (row number
not changed).

¢ If Al contains the formula =$D$5 then on copying the cell to B2 it will remain as =D5 (neither
the column letter nor the row number are changed).

When you are entering or editing a cell reference in a formula the shortcut key F4 can be used to
step through these four possibilities.

Named cells can be used in a similar way to include a unchanging cell reference in a formula.

4.3 Arithmetic using Special Paste

Sometimes you may want to add a single value to a number of cells, or subtract a value from
them, or multiply or divide them all by a single value. The Special Paste... option lets you do
this quickly and easily.

First, enter the modifier value into any spare cell on your spreadsheet and Copy it. Then select
the area of cells you want to change, choose Special Paste... from the Edit or the context menu
and select Addition, Subtraction, Multiplication or Division from the Operation section of the
dialog box.

You can also apply different modifier values to different rows or columns of the target area by
copying an area containing the wanted modifiers before selecting the target area and doing Spe-
cial Paste... For example, if you enter 5 into cell Al, 10 into B1, select both cells and do a Copy
then Special Paste... Addition into cells A10 to D15, 5 will be added to A10:A15 and C10:C15,
and 10 to B10:B15 and D10:D15.

Note that a modifier value can be a formula as well as a simple numeric value. If it is a formula
then Calligra Sheets will adjust the cell references as for a normal Paste operation.

4.4 Array Formulas

Calligra Sheets allows you to use formulas whose result is a matrix or a range of values. Nor-
mally, only the first value is displayed in a cell. If you would like to display the entire matrix,
simply use Ctrl-Alt-Enter when editing a formula, and it will be converted into an array formula,
occupying neighboring cells as needed.

Cells that are a part of an array formula are locked for editing.
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4.5 Goal Seeking

Calligra Sheets can be used to solve algebraic expressions such as x + x"2 = 4 or For what value of
x does x + x squared equal 4 ?

For this example you could enter =A2+A2%A2 into Al then either try different values in A2 until
the result in Al is as close as you wish to 4 or, preferably, use Calligra Sheets’s Goal Seek...
feature which automatically adjusts the value in one cell to try to make the value in another cell
as close as possible to a target value.

It is invoked by selecting Goal Seek... from the Data menu. This brings up a dialog box in which
you should enter the reference of the target value cell (A1 in this case) into the Set cell: box, the
target value itself (4) into the To value: box and the reference of the cell that is to be changed (A2)
into the By changing cell: box. Note that you need to have entered some initial value into the
cell that is to be changed before starting Goal Seek.

Pressing the OK button will start the calculation. When it finishes and if it has found a solution
press the OK button to accept the result or Cancel to keep the original value.

4.6 Pivot Tables

Calligra Sheets can be used to construct pivot tables using the data of the current table.

This feature can be invoked by selecting Pivot... from the Data menu. Below is an example of
pivot table generation.

Supposing we have the following data.

| A | B | c |
1 |Name Category Score
2 ligar Science ag
3 |Smith Math 80
4 llohn Science a5
3 |Smith Science 60
B ligar Math 81
7 |John Math ag

We want to create a pivot table of our choice and requirement. So we choose Data — Pivot....

The dialog box that will appear allows user to select the source of data. The data can be taken
from the current worksheet or from an external source like a database or ODS file.

(®) Current Selection

External Source

+ DK & Cancel
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Here is the dialog box which allows the user to customize the pivot table. The column labels
in the source data are converted to labels which serve as the working fields. The labels can be
dragged and dropped into one of three areas (Rows, Columns or Values) to generate the pivot
table. You can reset your choices using Reset DnD button.

Pivot Table Configuration Window - Calligra Sheets 7w e

Drag from Labels and drop in the desired field
Labels Rows

Name

Columns

Category

Select Option
sum ~ | Values
Score
[m] Total Rows

(M) Total Columns

Add Filter « OK & Cancel

In our example, Name is dragged to Rows, category to Columns, Score to Values. User defined
functions like sum, average, max, min, count, etc. can be selected from the Select Option list.

The Add Filter button can be used to open filter dialog box to filter the desired data. Using this
box you can define multiple filters based on the column label and the relationship between them
(And or Or). This would allow extreme freedom to customize the output.

Calligra Sheets <3=

Operator Field Condition Value
Score el ~ | | 81 e
Or “ | | Name Al == o
None b
" OK ® Cancel

Total Rows and Total Columns: checking these allow automatic totalling of corresponding rows
and columns in the pivot table.
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4.7 Using more than one Worksheet

When you start a new, empty, document with Calligra Sheets it will create a number of blank
worksheets. The number of sheets it creates is determined by the selected template.

Insert — Sheet will add another sheet to the document.

You can also switch between worksheets by using the Ctrl+PgDown to move to the next sheet,
Ctrl+PgUp to move to the previous one.

Worksheets are given the default names of Sheet1, Sheet2... You can give a sheet a different name
by right clicking on the tab and selecting Rename Sheet...

To remove a sheet from the document use the Remove Sheet option in the context menu that
pops up when you right click on the tab for the sheet you want to remove.

Other entries in the Format — Sheet submenu allow you to show or hide a sheet in much the
same way as rows and columns can be hidden.

If you want a formula in one sheet to refer to a cell in another sheet, the cell reference must start
with the sheet name followed by an exclamation mark (!). For example if you enter =Sheet2!A2
into a cell in Sheet 1, that cell will take the value from A2 of Sheet2. Note that sheet names are
case sensitive.

4.7.1 Consolidating Data

You may have constructed a document containing several worksheets containing similar data
but for, say, different months of the year, and wish to have summary sheet containing the consol-
idated (e.g., sum or average) values of the corresponding data items in the other sheets.

This task can be made slightly easier by using the Consolidate... item from the Data menu.
Selecting this option brings up the Consolidate dialog box.

For each of the source sheets, enter a reference to the desired data area in the Reference: box.

Press Add to transfer it to the Entered references: box. The reference should include the name
of the sheet containing the source data, such as January!A1:A10, and can be entered automat-

ically by selecting the area in the appropriate sheet.

After entering the references for all of the source data sheets select the cell in the target sheet
where you want the top left corner of the consolidated results to appear. Then choose the appro-
priate function from the Function: combo box and press the OK button.

If you click the Details » in the dialog and check the Copy data box the values resulting from the
consolidation will be placed into the target cells rather than the formulae to calculate them.

4.8 Inserting a Chart

You can insert a chart into a sheet to give a graphical view of your data.
First enable Add Shape docker using the Settings — Dockers menu item.

Then select the area of cells containing the data and choose Chart in the Add Shape. Drag the
cursor across the sheet while holding the left mouse button down to define the area where you
want the chart to appear, there is no need to be too accurate at this stage as the chart size can
easily be changed at any time. When you release the mouse button a Chart Options dialog box
will appear.

The data area is already prefilled with the selected cell range. Select the first row and column as
labels, check Data set in rows and click the OK button. The Dialog will vanish and you will see
the chart embedded into the worksheet.
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Now select Chart Editing Tool from the Tools docker and edit the chart properties like chart
type, labels and axis in the Chart editing.

Calligra Sheets

File Edit View Go Insert Format Data Tools Settings Help

A D
a fe || v ]
A B C D E F A & AddShape <]
1 Jan Feb Mar Apr
El
2 [sales 100 30 70 40 Ml .
3 (Cost 80 75 65 50 Chart_Image
4
5 =] o
s 200 - -
-—
— P [zo Data Ranges...
g 150 —— - Janoary cell ﬁ
8 - L - formating
9 % om—1 ey PlotArea | DataSets Legend
L, E— »
o R — | Labels
12 e} nanzﬁ:g ] itle (7] subtitle [T] Feoter
13 0 j j i
14 1 2 3 4 v e
15 Month (C0TRe Month M+ | =
16 shapes
17 © [H] Label | Month
18
19 Draw path [C] Show Grid Lines
20
2 I scaling... Edit Fonts,
22 Chart
= editing
24
25
A & shape Properties oD
4/ 4 v | sheet1 [ sheetz [ Sheet3 / wmm
Sum: 0 100% v sm—

To move, resize or even delete the embedded chart switch to the Basic shape manipulation tool
and click anywhere within the chart area. It should now appear with a green border and with a
small yellow square at each corner and in the middle of each edge.

If you move the cursor over any of the squares it should change to a double headed arrow. You
can resize the chart by dragging one of these squares with the left mouse button pressed. To
delete the chart right click on one of the squares and select Delete.

To move the chart move the cursor into the chart. The cursor should then change to a cross, press
the left mouse button and you will be able to drag the chart to where you want it to be.

To restore the chart to its normal appearance simply click anywhere outside of the chart area.

To change the format of the chart itself left click twice within the chart area. The chart Chart
editing should appear in the docker. You can then use these tools to change the chart.

4.9 Inserting External Data

You can insert data from a text file or from the clipboard into a worksheet by first selecting the
cell where you want the top left item of the inserted data to appear, then choosing From Text
File... or From Clipboard... from the Insert — External Data sub menu.

In both cases Calligra Sheets will assume that the data is in CSV form and will open a dialog box
allowing you to control how the data is extracted from the file or clipboard and placed into the
worksheet cells.

If support for it has been included in your system, Calligra Sheets can also insert data from a SQL
database into a worksheet. This is done by using the Insert — External Data — From Database...
option.
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410 Link Cells

A spreadsheet cell can be linked to an action so that left clicking on the cell will, for example,
open your browser. To make a cell act in this way select it and choose Insert — Link.... This will
bring up the Insert Link dialog box, which lets you choose between four types of link:

¢ An Internet link cell will try to open your default browser at the URL entered in the Internet
address: text box of the Insert Link dialog when it is clicked. This could be, for example,
http://www.calligra.org.

¢ Clicking on a cell containing a Mail link will open your email composer using the address
entered in the Email: text box as the To: address. For example anon@Qexample. com.

¢ A File link cell holds the path to a file or folder, as entered into the File location: text box, and
will try to open that file or folder with a suitable application when clicked on.

¢ The Cell type of link cell holds a Calligra Sheets cell reference, entered in the Cell or Named
Area text box. Left clicking on this type of link cell causes Calligra Sheets’s focus to move to
the target cell.

All four types of link cell need some suitable text to be entered into the Text to display field of
the Insert Link dialog. This is the text that appears in the cell.

411 Validity Checking

Calligra Sheets can automatically check the validity of entered data against a number of criteria,
and pop up a message box if the data is invalid.

To enable this feature, select the cell(s) to be monitored and choose Data — Validity.... This will
bring up Calligra Sheets’s Validity dialog box which has three tabbed pages.

In the Criteria page select what type of data is to be considered valid from the Allow: combo box
list then define the valid range of values by choosing one of the options in the Data: combo box
and entering suitable value(s) into one or both of the edit box(es).

When you have done this change to the Error Alert tab. Here you can choose the type of message
box (Stop, Warning or Information) that will appear when an invalid value is entered, and define
the message box title and message text.

Note that this feature only checks data that you enter into the cell, for a way of checking the
results from formulae cells see the Conditional Cell Attributes section of this Handbook.

412 Protection

4.12.1 Document Protection

Protecting the document means that without the password a user cannot add or delete sheets.
Document protection does not protect cells.

Select Tools — Protect Document... A dialog appears asking you for a password. The Password:
strength meter indicates if your password is secure enough. The longer the indicator is, the more
secure your password.
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Y

s # Protect D..raSheets

—
I.E.l Enter a password.

Passwords match [ =]

Password:  ©9000000008 A

verify: | ooeoeeeeeee| |

Password strength meter:

« OK & Cancel

That password will then be required to unprotect the document.

Unprotect Document — Calligra Sheets

Enter the password.

Password: ‘Il.ll & =

« 0K & Cancel

When a document is protected, you may not:

e Rename a sheet
¢ Insert a sheet

® Remove a sheet
¢ Hide a sheet

e Show a sheet

* See the sheet properties

* Merge or dissociate cells
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4.12.2 Sheet protection

Protecting a sheet means protecting the contents of all protected cells and objects on a sheet. In-
dividual cells or a selection of cells can be unprotected within a protected sheet, see next section.

To protect a sheet, select Tools — Protect Sheet.... A dialog appears asking you for a password.
The Password strength meter indicates if your password is secure enough. The longer the indi-
cator is, the more secure will be your password.

That password will then be required to unprotect the sheet.

When a sheet is protected, you may not:

* Insert any object or chart
¢ Format any cell

¢ Insert a row or a column

¢ Edit and change cell content

¢ Change any content in the sheet

NOTE
Protecting a sheet is especially useful for preventing accidental erasure of formulae.

4.12.3 Cell or selected cells protection

WARNING
Cell protection is active for all cells by default and is effective when you enable sheet protection. So if
you keep the default and if you protect the sheet, all cells will be protected.

If you want only certain cells to be protected, this default protection must be turned off for all
other cells. For example you might want most cells to accept user input so you will uncheck
Protected for those and choose to keep protected cells that should stay unchanged (such as titles).
So you need 3 steps in order to protect only some cells: unprotect all the cells, select the cells to
protect and protect them and then protect the whole sheet.

To unprotect all the cells:

Select the entire spreadsheet with the mouse.

¢ In the menubar, select Format — Cell Format....

In the dialog that appears, go to the Cell Protection tab.

Check Hide all and uncheck Protected to remove the protection on all cells. The cells are now
all unprotected.

To protect a range of selected cells or a selection of non-contiguous cells:

e Highlight the range of cells that are to be protected or use the Ctrl key to select non-contiguous
cells.

* When all of the desired cells are selected, go to the Format — Cell Format... menu.
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¢ In the dialog that appears, go to the Cell Protection tab.
® Click on the box next to Protected then click on OK.

Once the cells are marked for protection, the protection option must be enabled at the sheet level,
that means you must protect the entire sheet for the cell to be effectively protected:

e Select Tools — Protect Sheet....

¢ In the dialog that appears, provide a safe password, then confirm it by typing it again. Click
on OK.

® Protected cells in a protected sheet cannot be edited without unprotecting the whole sheet,
and any sheet changes are disabled. For example, no one can insert rows or columns, change
column width, or create embedded charts.

4.12.4 Hide cell formula

You might want to hide your formulae so other people cannot see them. By default, every cell
is protected and not hidden. But it is important to remember that these attributes have no effect
unless the sheet itself is protected.

Cell Editor
- [=AL+A2
A3 Qv s |« @
Tools < B
. 1 1
E3 z 2 2

To hide cell formulae, select the appropriate cell or range of cells or non-contiguous cells with
Ctrl and then choose the Format — Cell Format... menu. In the Cell format dialog, click the Cell
Protection tab and select Hide formula. After you protect the sheet, the results of the formulae
will be visible, but the formulae will not.

You have now to protect the sheet: choose Tools — Protect Sheet... to display the Protect Sheet
dialog box. Enter a safe password twice to prevent others from unprotecting the sheet.

When Hide formula is enabled and Protected is disabled, the formula is hidden after protecting
the sheet but the cell content can be changed.

[ Bl C—

1

L 4

1) = |y —

When Hide formula and Protected are enabled, the formula is hidden after protecting the sheet
and the cell content cannot be changed.
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Keep in mind that it is very easy to break the password for a protected sheet so if you are looking
for real security, this is not the best solution.

4.12.5 Hide all in the cell

You can hide both the formula and the content of the cell by choosing Hide all in the Cell Pro-
tection tab in the Format — Cell Format... menu. In the screenshot below, the cell itself is not
protected (Protected is unchecked) thus the cell content can be changed.
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Here the cell itself is protected so it cannot be overwritten.
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413 Other Features

4.13.1 Named Cells and Areas

You can give a name such as foo to a cell or to any area of a sheet by selecting the cell or area
then selecting Area Name... from the right mouse button menu. This will bring up the Area
Name dialog box where you can enter any name you wish.

You can also name a cell or area by selecting it then typing the name into the small text box at the
left end of the Formula toolbar, overwriting the cell reference that normally appears here.

If you enter a name that has already been used into this text box Calligra Sheets’s selection will
change to show the named cell(s).

The Data — Named Areas... option will give you a list of existing names and let you change
Calligra Sheets’s focus to any of them or let you remove a name.

Named cells are particularly useful in formulae as an alternative to absolute cell references as the
names can be used in place of normal cell references and do not change when the cell containing
the formula is copied. When a name is used in this way it should be enclosed in single quotation
marks.
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For example, if cell Al has been given the name fred then you can enter a formula such as
='fred’ + 2 into another cell which would always give the result of adding 2 to the value in
A1 no matter where the formula cell was copied to.

Note that cell and area names are treated as being in lowercase.

4.13.2 Cell Comments

A cell can contain a text comment that can be viewed when working on the spreadsheet but
which is not printed and not normally seen.

To add a comment select the cell and choose Comment... from the right mouse button menu or
from the Insert menu and type your comment into the resulting Cell Comment dialog box.

To see the comment hover the mouse pointer over the cell. The comment will appear as if it were
a Tooltip.

If you check the Show comment indicator box of the Sheet Properties dialog, those cells con-
taining comments will be highlighted by a small red triangle in the top right corner.

To open this dialog, click with the right mouse button onto the sheet tab at the bottom of the main

window and select Sheet Properties from the popup menu. Or select it from the Format — Sheet
menu.

To remove a comment from a cell, select Remove Comment from the right mouse button menu
or choose Edit — Clear - Comment.
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Chapter 5

Configuring Calligra Sheets
Shortcuts and Toolbars

Pamela Robert

5.1 Shortcuts

To change the shortcut key arrangements used by Calligra Sheets select Settings — Configure
Shortcuts... . This will launch a dialog box as shown below.

Configure Shortcuts — Calligra Sheets

Action ~ | Shortcut Alternate 4

Check Spelling ~ >

() Default: None

@ Custom: | & None | €@

[} Close > Ctrl+w > Ctrl+Esc
Color/Border » »
& Column > »
Column Header » »
[+ Defaults Manage Schemes == = Print... + OK ® Cancel

Search through the list box to find the action you want to add or change the shortcut keys for
and select it by left clicking on the name. By entering the name of the action in the search bar at
the top you can quickly find the desired action. You will then be able to change the shortcut by
selecting the None, Default or Custom radio button.

You can now simply press the key combination you want to act as the shortcut, for example
Ctrl+Shift+S.
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5.2 Toolbars

Calligra Sheets has six toolbars: File, Edit, Navigation, Format, Font and Color/Border. each of
which may or may not be shown depending on the choices made in the Settings menu.

If the toolbars are unlocked, you can choose whether a toolbar appears at the Top, Left, Right or
Bottom of Calligra Sheets’s window by right clicking on the toolbar, which brings up the Toolbar
Menu, and making a selection from the Orientation sub menu. This Toolbar Menu also has sub
menus for choosing whether the toolbar displays icons, text or both, and the size of the icons.

Another way of moving a toolbar is by positioning the mouse pointer over the two vertical bars
at the left end of each toolbar and holding the left mouse button down while you drag the toolbar
to the wanted position. When you drag the toolbar in this way you can release the mouse button
when it is some distance from any of Calligra Sheets’s window sides, and then you will get a
floating toolbar, which is not locked to any particular part of Calligra Sheets’s window and can
in fact be moved outside of the window. To put a floating toolbar back into one of the traditional
positions right click on its titlebar to bring up the Toolbar Menu then choose one of the options
in the Orientation sub menu.

Selecting Configure Toolbars... from the Settings menu will bring up a dialog box which lets
you add buttons to or remove them from Calligra Sheets’s toolbars.

To use this Configure Toolbars dialog box first select a toolbar from the Toolbar: combo box. The
right hand Current actions: window will then show the buttons currently present on the toolbar.
You can remove a button by selecting it in this window then pressing the left arrow button, or
move it around by pressing the up and down arrow buttons. To add a new button to the toolbar
select it in the Available actions: list then press the right arrow button.
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Chapter 6

The Calligra Sheets Configuration
Dialog Box

Pamela Robert

Selecting Settings — Configure Calligra Sheets... opens a dialog box with several pages, se-
lected with the icons at the left of the dialog box, which allow you to change many aspects of
Calligra Sheets’s operation.

6.1 Interface

Configure — Calligra Sheets

Interface
|ED Cursor movement after pressing Enter: | Down v
Open/Save Function shown in status bar: | Sum ~
h’.\ A Unit: | Millimeters (1~
Plugins N
Indentation step: 353mm O
Colors
Spelling
j Grid. v

Author page outline: | [N -

[ Reset Defaults v 0K © Cancel

Cursor movement after pressing Enter:

Select whether pressing the Enter key will move the cursor Down, Up, Right, Left, Down,
First Column or None as determined by the setting in this drop down selection box.
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Function shown in the status bar:

This drop down selection box can be used to choose the calculation performed by the Sta-
tusbar Summary function.

Unit:
Choose the default unit that will be used in your sheets.
Indentation step:

Set the amount of indent that will be used in the cell when you choose the Increase In-
dent/Decrease Indent actions from the toolbar. These actions are not enabled by default in
the toolbar.

Capture all navigation keys while editing

Captures all navigation keys, i.e. the arrow keys, page up/down, tabulator and backward
tabulator key, while editing a cell with the embedded editor. The embedded editor is the
one appearing directly in the cell. If captured, these keys are used for navigating in the
editor. Otherwise, they are used for cell navigation.

The Colors section lets you choose the color of the sheet grid. If you do not want the grid to
appear at all, uncheck the Show grid box in the Format — Sheet — Sheet Properties dialog.

This section also lets you select the color of the lines used to indicate the printed page borders
when the Page Borders box in the View menu is checked.

Select Custom from the current color to display the standard KDE Select Color dialog.
Grid
Click here to change the grid color i.e. the color of the borders of each cell.

Page border

When the View — Show Page Borders menu item is checked, the page borders are dis-
played. Click here to choose another color for the borders than the default red.

6.2 Open/Save

Configure — Calligra Sheets

Open/Save

Interface
Number of entries in Recent Files list: 10

Autosave interval: 5 min >
E;\ | Create backup file:

Plugins

A

Spelling

)|

Author

[ Reset Defaults v OK © Cancel
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Number of entries in Recent Files list:

Controls the maximum number of filenames that are shown when you select File — Open
Recent.

Autosave interval:

Here you can select the time between autosaves, or disable this feature altogether by choos-
ing No autosave (by selecting the minimum value).

Create backup file:
Check this box if you want some backup files created. This is checked per default.

6.3 Plugins

Configure — Calligra Sheets

- - B
Plugins
Interface - :
Search...
Open/Save Function Modules
A i & Bit Operation Functions @
: — BITAND, BITOR, BITXOR, BITLSH...
Plugins
L w Conversion Functions @
A * ARABIC, ASCIITOCHAR, BOOL2L...
Spelling 0O Database Functions @
= DAVERAGE, DCOUNT, DCOUNTA, ..
K '1 w DateTime Functions @
Author - CURRENTDATE, CURRENTDATETL...
& Engineering Functions @
— BASE, BESSELI, BESSEL], BESSEL...
& Financial Functions m@
* ACCRINT, ACCRINTM, AMORDEG...
0 Information Functions @
= ERRORTYPE, FILENAME, INFO, IS...
= Logic Functions.
® o @

AND, FALSE, IF, NAND, NOR, NO...

— Math Functions
— ABS, CEIL, CEILING, COUNT, CO...

& Reference Functions m@
* ADDRESS, AREAS, CHOOSE, COL...
— Statistical Functions =
[ Reset Defaults v OK © Cancel

Check a plugin in the list to enable it. Display the About dialog by clicking the info button at the
right side of the list item.
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6.4 Spelling

Configure — Calligra Sheets

Interface

=

Open/Save

B

Plugins

A

Spelling

(]

Author

[ Reset

Spell Checker Behavior

Default language: | American English (United States)

I:\ American English (United States)
[ (raevem nmay

Options
(W] Enable autodetection of language
) Automatic spell checking enabled by default
[C] skip all uppercase words
@ Skip run-together words

Ignored Words:
+ Add
Amarok l — Remaove
KAddressBook
KDevelop
KHTML
Defaults v OK © Cancel

This page lets you configure the behavior of Calligra Sheets’s spell checker.

For more information please refer to the Spell Checker documentation.

6.5 Author

Interface

Open/Save
B
Plugins

A

Spelling

ﬂ

Author

[ Reset

Configure — Calligra Sheets

Author
John Doe V| &l &

Name: | John Doe

Initials: |J. |

Title:
Position:
Company:
Email:
Telephone (home}:
Telephone (work):
Fax:
Street:
Postal code:
City:
Country:

v 0K

Defaults © Cancel

Choose an author profile for your document.
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You can add a new profile or delete the current profile using the buttons to the right of the profiles
drop-down list.
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Chapter 7
Command Reference

Pamela Robert

7.1 The File Menu

File — New (Ctrl+N)
Create a new document.
File — Open... (Ctrl+O)

Open an existing document.

File — Open Recent

Open an existing document by selecting it from a combo box of recently used files.

File — Save (Ctrl+S)
Save the document.

File — Save As...

Save and change the current document to a new name or format. If you want to keep the
name and format of the document use Export...

File — Reload
Reloads the document.

File — Import...
Import other documents.

Tables of data are often held in text files with the values in a line being separated by a
comma, space, tab or other character, for example 123, 456, 789, abcd, efgh. Such files are
commonly called ‘CSV’ (Comma Separated Values) files, even though the separating char-
acter may not be a comma.

If you ask Calligra Sheets to open a text file it assumes that the file is in CSV format and
launches a dialog box that allows you to specify the delimiter (separating character) used
by the file, and shows how the data items will be placed into different spreadsheet cells.

Other options in this dialog box let you define the Format of the spreadsheet cells, whether
text quote characters should be removed, and whether the first line(s) of the file should be
ignored.
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File — Export...

Save a document to any supported format. The document does not become the exported
file.

File — Mail...
Send the file as an email attachment.

File — Create Template From Document...

Create a Calligra Sheets template based on this document.
File — Print... (Ctrl+P)

Print the document.
File — Print Preview...

View the document as it will be printed.
File — Document Information

View or enter information about the document and author.
File — Close (Ctrl+W)

Close the current document but leave Calligra Sheets running.
File — Quit (Ctrl+Q)

Quit Calligra Sheets.

7.2 The Edit Menu

Edit — Undo (Ctrl+Z)
Undo the last action.

Edit — Redo (Ctrl+Shift+Z7)
Redo the last undone action.

Edit — Cut (Ctrl+X)

Put selected item(s) into the clipboard and remove them from the original location. If you
then do a Paste the item(s) will be inserted at the new location.

Edit — Copy (Ctrl+C)

Copy selected item(s) to the clipboard.
Edit — Paste (Ctrl+V)

Paste item(s) from the clipboard to the selected cell(s).
Edit — Special Paste...

Special forms of Paste. See the sections Other Paste Modes and Arithmetic using Special
Paste for more details.

Edit — Paste with Insertion
Move content of the paste area either to the right or down and paste item(s) from the clip-
board to the selected cell(s).

Edit — Fill

Fills up the selected area with the values from the first item-set. All four directions are
supported. Note that the term “item-set” describes the first set of values seen in the fill
direction. If the fill direction is Left then the first item-set is the last column of the selection.
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Edit — Find... (Ctrl+F)
Find cell containing given text.

Edit — Find Next (F3)
Find the next cell containing given text.

Edit — Find Previous (Shift+F3)
Find the previous cell containing given text.

Edit — Replace... (Ctrl+R)
Find and replace given text in cell(s).

Edit — Clear

Clear All or Contents, Comment, Conditional Styles, Link or Validity from selected
cell(s).

Edit — Delete
Delete Cells, Columns, Rows or Sheet.

Edit — Modify Cell (F2)

To modify selected cell in-situ.

7.3 The View Menu

View — New View
Open a new instance of Calligra Sheets with the same document.

View — Page Borders
Toggle marking of printed page borders in the sheet with red lines.

View — Zoom

Increase or decrease the magnification used to display the spreadsheet. Range from 33% to
500%.

7.4 The Go Menu

In this menu you find actions to navigate between the sheets of the currently opened spreadsheet
and the Goto Cell action to jump to a single cell or to select a range of cells.

7.5 The Insert Menu

Insert — Comment
Add or modify a comment.

Insert — Function...
Insert a mathematical function. See the section Formulae for more details.

Insert — Series...
Insert a series. See the section Series for more details.
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Insert — Link...
Insert a link into the selected cell. See the section Link Cells for more details.

Insert — Special Character...
Insert a special character into the selected cell.

Insert — External Data

Insert data From Database..., From Text File... or From Clipboard.... See the section Insert-
ing External Data for more details.

7.6 The Format Menu

Format — Cell Format... (Alt+Ctrl+F)
Format selected cell(s). See the Spreadsheet Formatting section for more details.

Format — Style Manager
Create, Modify or delete cell format styles.

Format — Style
Apply a style to selected cell(s). To manage styles use Format — Style Manager...

Format — Create Style From Cell...

Create a new style from the format of the selected cell. To manage styles use Format — Style
Manager...

Format — AutoFormat...
Autoformat the selected cells: a dialog let you choose between two proposed formats.

Format — Merge Cells

Merge selected cells.

Format — Dissociate Cells
Dissociate (split apart) previously merged cells.

Format — Adjust Row & Column

Set row and column sizes to show selected cell(s) properly.

Format — Row
Resize, equalize, hide or show row(s).

Format — Column
Resize, equalize, hide or show column(s).

Format — Sheet
Hide, show worksheet or configure advanced sheet properties.

Format — Page Layout...

Format printed page layout.

Format — Print Range

Define or reset the print range.
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7.7 The Data Menu

Data — Sort...
Sort data in selected cells. See the section Sorting Data for more details.

Data — Text to Columns...

This option attempts to interpret text in the selected cell(s) as CSV data, placing each item
into a different cell in the row.

Data — Named Areas... (Ctrl+Shift+G)

Open the Named Areas dialog to select, add, edit and remove named areas. See the section
Named Cells and Areas for further details.

Data — Consolidate...
Consolidate data. See the section Consolidating Data for more details.

Data — Subtotals...
Create different kinds of subtotals to a database.
Data — Validity...
Set or modify the error checking criteria and error alert message for selected cell(s). See
Validity Checking for more details.
Data — Goal Seek...
Open the Goal Seek dialog box. See Goal Seeking for details.

Data — Pivot...
Open the Pivot Table configuration dialog. See Pivot Table for details.

7.8 The Tools Menu

Tools — Spelling...
Check spelling of words in the worksheet.

Tools — Custom Lists...

View or amend the special series of words recognized by Calligra Sheets. These list can be
used to insert special series into the worksheet.

Tools — Protect Sheet...
Protect the sheet with a password. A dialog pops up prompting you for a password.
Unchecking this option will prompt you for the password in order to unprotect the sheet.
Protecting a sheet means protecting all cells in the sheet. In a protected sheet, the cells
cannot be reformatted or overwritten.

Tools — Protect Document...

Protect the whole document with a password. A dialog pops up prompting you for a pass-
word. Unchecking this option will prompt you for the password in order to unprotect the
document. In a protected document you cannot rename or remove a sheet. Document
protection does not mean that each individual sheet is protected.

Tools — Recalculate Sheet (Shift+F9)
Recalculate formulae in the current sheet.

Tools — Recalculate Document (F9)
Recalculate all sheets.
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Tools — Execute Script File...

Execute the chosen external script in Calligra Sheets. Calligra Sheets supports scripting in
JavaScript, Python and Ruby. Default examples of the scripts can be found in the Tools
— Scripts submenu.

Tools — Scripts

Here you can execute the script to export or import data in various formats, save your Cal-
ligra Sheets log into file, use Orca speech for accessibility, debug Python and Ruby scripts
or add functions to display stock or weather condition values. You can even use some R
functions (RPy module should be installed).

Tools — Script Manager...

Opens the Scripts Manager dialog to execute, load, unload, install, uninstall and get more
scripts.

Tools — Function Optimizer...

Opens the Function Optimizer dialog where you can choose an objective function cell, op-
timization target (Maximize, Minimize or enter the Value) and a set of decision parameter
cells.

7.9 The Settings Menu

Settings — Toolbars Shown
Show or hide the toolbars: File, Edit, Navigation, Font, Format and Color/Border.

Settings — Status Bar

Show or hide the Status Bar. The Status Bar shows additional information for selected items
and instant calculations of the selected cells.

Settings — Tab Bar

Show or hide the Tab Bar. All Sheets of the current Document can be accessed through the
Tab Bar.

Settings — Configure Shortcuts...

Configure the keyboard shortcuts used by Calligra Sheets. See the section on configuring
shortcuts for more details.

Settings — Configure Toolbars...

Configure the toolbars. The section on configuring toolbars has more information.

Settings — Themes

Choose the color theme for Calligra Sheets window. You can choose one of the predefined
color schemes or select Configuration... to open System Settings color selection module.

Settings — Active Author Profile

Configure the author profile for the current document. You can choose one of the profiles
defined using Calligra Sheets configuration window, Default Author Profile as defined by
System Settings data or blank Anonymous profile which can ensure your privacy.

Settings — Configure Notifications...

Configure Calligra Sheets notification system. There are no actions that you can be notified
in the current version of Calligra Sheets.

Settings — Configure Calligra Sheets...

General Calligra Sheets configuration. See the section on Calligra Sheets configuration for
more details.
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710 The Help Menu

Help — Calligra Sheets Handbook (F1)
Invokes the KDE Help system starting at the Calligra Sheets help pages. (this document).

Help — What's This? (Shift+F1)

Changes the mouse cursor to a combination arrow and question mark. Clicking on items
within Calligra Sheets will open a help window (if one exists for the particular item) ex-
plaining the item’s function.

Help — Report Bug...
Opens the Bug report dialog where you can report a bug or request a ‘wishlist” feature.

Help — Switch Application Language...

Opens a dialog where you can edit the Primary language and Fallback language for this
application.

Help — About Calligra Sheets
This will display version and author information.

Help — About KDE

This displays the KDE version and other basic information.

711 The Right Mouse Button Menu

This section describes the items in the pop up menu obtained by right clicking on a selected cell
or cells, row(s) or column(s).

Cell Format... (Ctrl+Alt+F)
Format selected cell(s). See the Spreadsheet Formatting section for more details.

Cut (Ctrl+X)

Put selected item(s) into the clipboard. If you then do a Paste the item(s) will be moved
from the original location to the new one.

Copy (Ctrl+O)
Copy selected item(s) into the clipboard.
Paste (Ctrl+V)
Paste item(s) from the clipboard to the selected cells.

Special Paste...

Special forms of Paste. See the sections Other Paste Modes and Arithmetic using Special
Paste for more details.

Paste with Insertion
Paste from the clipboard to the selected cell(s), moving the previous cell(s) to make room.

All
Delete contents of selected cell(s).

Adjust Row & Column

Change size of row and column to display selected cell(s) completely.
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Default
Set default formats for selected cell(s).

Area Name...
Name selected area. See the section Named Areas for more details.
Resize Row...
Change height of selected row.
Adjust Row
Change height of selected row to display cell(s) completely.
Resize Column...
Change width of selected column.
Adjust Column
Change width of selected column to display cell(s) completely.

Insert Cells...
Insert new cell(s) at selected location, moving existing cell(s) to make room.

Delete Cells...
Remove selected cell(s), moving other cell(s) to occupy the space left by the removed cell(s).

Insert Rows
Insert new row(s) above selected row(s).

Delete Rows
Delete selected row(s).

Hide Rows
Hides selected row(s).

Show Rows
Shows selected row(s). In order to show hidden rows you need to select a range of rows
that includes the hidden rows.

Insert Columns
Insert new column(s) at left of selected column(s).

Delete Columns
Delete selected columny(s).

Hide Columns
Hides selected column(s).

Show Columns
Shows selected column(s). In order to show hidden columns you need to select a range of
columns that includes the hidden columns.

Comment...
Add or modify a comment to the selected cell.

Selection List...

Lets you select and paste text from any cell of the current selection of cells into the selected
cell.
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7.12 Other Shortcuts

This section describes those Calligra Sheets shortcut keys used for operations that do not appear
in any of the menus.

Ctrl+H
Toggle the display of the dockers.
Ctrl+Arrow keys

If the selected cell is occupied then move the cell cursor to the start or end of the occupied
block in the current row or column. If the selected cell is not occupied then move the cell
cursor to the start or end of the block of unoccupied cells in the current row or column.

Ctrl+Shift+ Arrow keys

If the selected cell is occupied then select all occupied cells to the start or end of that block
of occupied cells in the current row or column. If the selected cell is not occupied then select
all unoccupied cells to the start or end of that block of unoccupied cells in the current row
or column.

Page Down

Move the cell cursor 10 cells down.
Page Up

Move the cell cursor 10 cells up.
Ctrl+Page Down

Move to the next sheet.
Ctrl+Page Up

Move to the previous sheet.

F4
Change cell reference between normal and absolute reference types.
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Chapter 8

Functions

Calligra Sheets has a huge range of built in mathematical and other functions that can be used in
a formula cell.

8.1 Supported Functions

This chapter holds a brief overview of all supported functions in the following groups:

Bit Operations
Conversion
Database
Date & Time
Engineering
Financial
Information
Logical
Lookup & Reference
Math
Statistical
Text
Trigonometric

8.1.1 Bit Operations

8.1.1.1 BITAND

The BITAND() function performs a bit-wise AND operation for the two integer parameters.
Return type: Whole number (like 1, 132, 2344)

Syntax
BITAND(value; value)

Parameters

Comment: First number, Type: Whole number (like 1, 132, 2344)
Comment: Second number, Type: Whole number (like 1, 132, 2344)
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Examples

BITAND(12;10) returns 8 (because decimal 12 is binary 1100, and decimal 10 is binary 1010;
and 1100 “anded” with 1010 is 1000, which is integer 8).

Related Functions

BITOR
BITXOR

8.1.1.2 BITLSHIFT

The BITLSHIFT() function performs a bit-wise left shift operation of the first parameter. The
number of bits to shift by is specified by the second parameter. Note that a negative number of
bits to left shift by becomes a right shift.

Return type: Whole number (like 1, 132, 2344)

Syntax
BITLSHIFT (value; shift size)

Parameters

Comment: First number, Type: Whole number (like 1, 132, 2344)
Comment: Amount to left shift by, Type: Whole number (like 1, 132, 2344)

Related Functions
BITLSHIFT

8.1.1.3 BITOR

The BITOR() function performs a bit-wise OR operation for the two integer parameters.
Return type: Whole number (like 1, 132, 2344)

Syntax
BITOR(value; value)

Parameters
Comment: First number, Type: Whole number (like 1, 132, 2344)
Comment: Second number, Type: Whole number (like 1, 132, 2344)
Examples
BITOR(12;10) returns 14 (because decimal 12 is binary 1100, and decimal 10 is binary 1010;
and 1100 “ored” with 1010 is 1110, which is integer 14).

Related Functions

BITAND
BITXOR
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8.1.1.4 BITRSHIFT

The BITRSHIFT() function performs a bit-wise right shift operation of the first parameter. The
number of bits to shift by is specified by the second parameter. Note that a negative number of
bits to right shift by becomes a left shift.

Return type: Whole number (like 1, 132, 2344)

Syntax
BITRSHIFT(value; shift size)

Parameters

Comment: First number, Type: Whole number (like 1, 132, 2344)
Comment: Amount to right shift by, Type: Whole number (like 1, 132, 2344)

Related Functions
BITLSHIFT

8.1.1.5 BITXOR

The BITXOR() function performs a bit-wise exclusive-OR operation for the two integer parame-
ters.

Return type: Whole number (like 1, 132, 2344)

Syntax
BITXOR(value; value)

Parameters

Comment: First number, Type: Whole number (like 1, 132, 2344)
Comment: Second number, Type: Whole number (like 1, 132, 2344)

Examples

BITXOR(12;10) returns 6 (because decimal 12 is binary 1100, and decimal 10 is binary 1010;
and 1100 “xored” with 1010 is 0110, which is integer 6).

Related Functions

BITAND
BITOR

8.1.2 Conversion

8.1.2.1 ARABIC

The ARABIC() function converts a roman numeral into a number.
Return type: Whole number (like 1, 132, 2344)

Syntax
ARABIC(Numeral)

Parameters
Comment: Numeral, Type: Text
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Examples
ARABIC("IV”) returns 4

Examples
ARABIC("XCIX") returns 99

Related Functions
ROMAN

8.1.2.2 ASCIITOCHAR

The ASCIITOCHAR() function returns the character for each given ASCII code
Return type: Text

Syntax
ASCIITOCHAR(value)

Parameters
Comment: The ASCII values to convert, Type: Whole number (like 1, 132, 2344)

Examples
ASCIITOCHAR(118) returns “v”

Examples
ASCIITOCHAR(75; 68; 69) returns "KDE”

8.1.2.3 BOOL2INT

The BOOL2INT() function returns an integer value for a given boolean value. This method is
intended for using a boolean value in methods which require an integer.

Return type: Whole number (like 1, 132, 2344)

Syntax
BOOL2INT(value)

Parameters
Comment: Bool value to convert, Type: A truth value (TRUE or FALSE)

Examples
BOOL2INT(True) returns 1

Examples
BOOL2INT(False) returns 0

Related Functions
INT2BOOL
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8.1.24 BOOL2STRING
The BOOL2STRING() function returns a string value for a given boolean value. This method is
intended for using a boolean in methods which require a string

Return type: Text

Syntax

BOOL2STRING(value)
Parameters

Comment: Bool value to convert, Type: A truth value (TRUE or FALSE)
Examples

BOOL2STRING(true) returns “True”

Examples
BOOL2STRING(false) returns “False”

Examples
upper(BOOL2STRING(find("nan”;"banana”))) returns TRUE

8.1.2.5 CARX
The CARX() function returns the X position corresponding to the position of a point in a polar

landmark.
Return type: Double

Syntax
CARX(Radius;Angle)

Parameters

Comment: Radius, Type: Double
Comment: Angle (radians), Type: Double

Examples
CARX(12;1.5707) returns 0.00115592

Examples
CARX(12,0) returns 12

Related Functions

CARY
POLA
POLR

8.1.2.6 CARY

The CARY() function returns the Y position corresponding to the position of a point in a polar
landmark.

Return type: Double
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Syntax
CARY(Radius;Angle)

Parameters

Comment: Radius, Type: Double
Comment: Angle (radians), Type: Double

Examples

CARY(12;1.5707) returns 12

Examples
CARY(12;0) returns 0

Related Functions

CARX
POLA
POLR

8.1.2.7 CHARTOASCII

The CHARTOASCII() function returns the ASCII code for the given character.
Return type: Whole number (like 1, 132, 2344)

Syntax
CHARTOASCII(value)

Parameters
Comment: A one character string to convert, Type: Text

Examples
CHARTOASCII("v") returns 118

Examples
CHARTOASCII(r) is an error. The character must be in quotes.

8.1.2.8 DECSEX

The DECSEX() function converts a double value to a time value.

Return type: Double

Syntax
DECSEX(double)

Parameters
Comment: Value, Type: Double

Examples
DECSEX(1.6668) returns 1:40

Examples
DECSEX(7.8) returns 7:47
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8.1.2.9 INT2BOOL

The INT2BOOLY() function returns a boolean value for a given integer number. This method is
intended for using an integer in methods which require a boolean. It only accepts 0 or 1. If any
other value is given, false is returned.

Return type: A truth value (TRUE or FALSE)

Syntax
INT2BOOL(value)

Parameters
Comment: Integer value to convert, Type: Whole number (like 1, 132, 2344)

Examples
INT2BOOL(1) returns true

Examples
INT2BOOL(0) returns false

Examples
OR(INT2BOOL(1); false) returns true

Related Functions
BOOL2INT

8.1.2.10 NUM2STRING

The NUM2STRING() function returns a string value for a given number. Note that Calligra
Sheets can auto-convert numbers to strings if needed, so this function should rarely be needed.

Return type: Text

Syntax
NUM2STRING(value)

Parameters
Comment: Number to convert into string, Type: A floating point value (like 1.3, 0.343, 253 )

Examples
NUM2STRING(10) returns “10”

Examples
NUM2STRING(2.05) returns “2.05”

Examples
=find("101";NUM2STRING(A1)) (Al = 2.010102) returns True

Related Functions
STRING
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8.1.2.11 POLA

The POLA() function returns the angle (in radians) corresponding to the position of a point in a
cartesian landmark.

Return type: Double

Syntax
POLA(X;Y)

Parameters

Comment: Value in X, Type: Double
Comment: Value in Y, Type: Double

Examples
POLA(12;12) returns 0.78539816

Examples
POLA(12;0) returns 0

Examples
POLA(0;12) returns 1.5707

Related Functions

POLR
CARX
CARY

8.1.2.12 POLR

The POLR() function returns the radius corresponding to the position of a point in a cartesian
landmark.

Return type: Double

Syntax
POLR(X;Y)

Parameters

Comment: Value in X, Type: Double
Comment: Value in Y, Type: Double

Examples
POLR(12;12) returns 16.9705

Examples
POLR(12;0) returns 12

Related Functions

POLA
CARX
CARY
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8.1.213 ROMAN

The ROMAN() function returns the number in Roman format. Only positive whole numbers can
be converted. The optional Format argument specifies the level of conciseness, and defaults to 0.

Return type: Text

Syntax
ROMAN(Number)

Parameters

Comment: Number, Type: Whole number (like 1, 132, 2344)
Comment: Format, Type: Whole number (like 1, 132, 2344)

Examples
ROMAN(99) returns “"XCIX”

Examples
ROMAN(-55) returns “Err”

Related Functions
ARABIC

8.1.2.14 SEXDEC

The SEXDEC() function returns a decimal value. You can also supply a time value.

Return type: Double

Syntax
SEXDEC(time value) or SEXDEC(hours;minutes;seconds)

Parameters

Comment: Hours, Type: Whole number (like 1, 132, 2344)
Comment: Minutes, Type: Whole number (like 1, 132, 2344)
Comment: Seconds, Type: Whole number (like 1, 132, 2344)

Examples
SEXDEC(1;5;7) returns 1.0852778

Examples
DECSEX("8:05") returns 8.08333333

8.1.2.15 STRING

The STRING() function returns a string value for a given number. It is the same as the
NUM2STRING function.

Return type: Text

Syntax

Parameters
Comment: Number to convert into string, Type: A floating point value (like 1.3, 0.343, 253 )

Related Functions
NUM2STRING
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8.1.3 Database

8.1.3.1 DAVERAGE

Calculates the average in a column of a database specified by a set of conditions for values that
are numbers

Return type: FLOAT

Syntax
DAVERAGE(Database; “Header”; Conditions)

Parameters
Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings
Examples

DAVERAGE(A1:C5; “Salary”; A9:A11)

8.1.3.2 DCOUNT

Counts the cells containing numeric values in a column of a database specified by a set of condi-
tions.

Return type: FLOAT

Syntax
DCOUNT(Database; “Header”; Conditions)

Parameters

Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings

Examples
DCOUNT/(A1:C5; “Salary”; A9:A11)

Related Functions
DCOUNTA

8.1.3.3 DCOUNTA

Counts the cells containing numeric or alphanumeric values in a column of a database specified
by a set of conditions.

Return type: FLOAT

Syntax
DCOUNTA (Database; “Header”; Conditions)

Parameters

Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings
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Examples
DCOUNTA(A1:C5; “Salary”; A9:A11)

Related Functions
DCOUNT

8.1.34 DGET

Returns a single value from a column of a database specified by a set of conditions. This function
returns an error if no value or more than one value exist.

Return type: FLOAT

Syntax
DGET(Database; “Header”; Conditions)

Parameters

Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings

Examples
DGET(A1:C5; “Salary”; A9:A11)

8.1.3.5 DMAX

Returns the largest value in a column of a database specified by a set of conditions.
Return type: FLOAT

Syntax
DMAX(Database; “Header”; Conditions)

Parameters

Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings

Examples
DMAX(A1:C5; “Salary”; A9:A11)

Related Functions
DMIN

8.1.3.6 DMIN

Returns the smallest values in a column of a database specified by a set of conditions.
Return type: FLOAT

Syntax
DMIN(Database; “Header”; Conditions)
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Parameters

Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings

Examples
DMIN(A1:C5; “Salary”; A9:A11)

Related Functions
DMAX

8.1.3.7 DPRODUCT

Returns the product of all numeric values in a column of a database specified by a set of condi-
tions.

Return type: FLOAT

Syntax
DPRODUCT(Database; “Header”; Conditions)

Parameters

Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings

Examples
DPRODUCT(A1:C5; “Salary”; A9:A11)

8.1.3.8 DSTDEV

Returns the estimate of the standard deviation of a population based on a sample using all nu-
meric values in a column of a database specified by a set of conditions.

Return type: FLOAT

Syntax
DSTDEV(Database; “Header”; Conditions)

Parameters

Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings

Examples
DSTDEV(A1:C5; “Salary”; A9:All)

Related Functions
DSTDEVP
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8.1.3.9 DSTDEVP

Returns the standard deviation of a population based on the entire population using all numeric
values in a column of a database specified by a set of conditions.

Return type: FLOAT

Syntax
DSTDEVP(Database; “Header”; Conditions)

Parameters

Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings

Examples
DSTDEVP(A1:C5; “Salary”; A9:Al1)

Related Functions
DSTDEV

8.1.3.10 DSUM

Sums up the numbers in a column of a database specified by a set of conditions.
Return type: FLOAT

Syntax
DSUM(Database; “Header”; Conditions)

Parameters

Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings

Examples
DSUM(A1:C5; “Salary”; A9:Al1)

8.1.3.11 DVAR

Returns the estimate of the variance of a population based on a sample using all numeric values
in a column of a database specified by a set of conditions.

Return type: FLOAT

Syntax
DVAR(Database; “Header”; Conditions)

Parameters

Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings

Examples
DVAR(A1:C5; “Salary”; A9:A11)

Related Functions
DVARP
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8.1.3.12 DVARP

Returns the variance of a population based on the entire population using all numeric values in
a column of a database specified by a set of conditions.

Return type: FLOAT

Syntax
DVARP(Database; "Header”; Conditions)

Parameters

Comment: Range marking the database, Type: A range of strings
Comment: String marking the column in the database, Type: Text
Comment: Range marking the conditions, Type: A range of strings

Examples
DVARP(A1:C5; “Salary”; A9:A11)

Related Functions
DVAR

8.1.3.13 GETPIVOTDATA

Fetches summary data from a pivot table.
Return type: FLOAT

Syntax
GETPIVOTDATA (Database; “Sales”)

Parameters

Comment: Range containing the pivot table, Type: A range of strings
Comment: Name of the field of which you want the summary data, Type: Text

8.1.4 Date & Time

8.14.1 CURRENTDATE

The CURRENTDATE() function returns the current date. It is equivalent to the TODAY function.
Return type: Date

Syntax
CURRENTDATE()

Parameters
Examples

CURRENTDATE() returns “Saturday 13 April 2002”

Related Functions

CURRENTTIME
TODAY
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8.1.4.2 CURRENTDATETIME

The CURRENTDATETIME() function returns the current date and time.
Return type: Date

Syntax
CURRENTDATETIME()
Parameters

Examples
CURRENTDATETIME() returns “Saturday 13 April 2002 19:12:01"

8.1.4.3 CURRENTTIME

The CURRENTTIME() function returns the current time formatted with local parameters.
Return type: Date

Syntax
CURRENTTIME()
Parameters
Examples
CURRENTTIMEY() returns "19:12:01”

8.1.4.4 DATE

The DATE() function returns the date formatted with local parameters.
Return type: Text

Syntax
DATE(year;month;date)
Parameters
Comment: Year, Type: Whole number (like 1, 132, 2344)

Comment: Month, Type: Whole number (like 1, 132, 2344)
Comment: Day, Type: Whole number (like 1, 132, 2344)

Examples
DATE(2000;5;5) returns Friday 05 May 2000

8.1.4.5 DATE2UNIX

DATE2UNIX() function converts a date and time value to unix time.
A unix time is the number of seconds after midnight January 1st, 1970.
Return type: Whole number (like 1, 132, 2344)

Syntax
DATE2UNIX(date)

Parameters
Comment: Date, Type: Text

Examples
DATE2UNIX("01/01/2000") returns 946,684,800
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8.1.4.6 DATEDIF

The DATEDIF() function returns the difference between two dates.

Interval must be one of the following: “m”: month; "d”: days; “y”: complete years; “ym"”: month
excluding years; "yd": days excluding years; “md”: days excluding months and years

Return type: Whole number (like 1, 132, 2344)

Syntax
DATEDIF(first date; second date; interval)

Parameters

Comment: First date, Type: Text
Comment: Second date, Type: Text
Comment: interval, Type: Text

Examples

DATEDIF(A1;A2;"d") Al is “1st of January 1995” and A2 is "15th of June 1999” returns
number of days 1626

Examples

DATEDIF(A1;A2;"m") Al is "1st of January 1995” and A2 is “15th of June 1999” returns
number of months 53

8.1.4.7 DATEVALUE

The DATEVALUE function returns a number representing the day, i.e the number of days elapsed
since December 31, 1899.

Return type: Whole number (like 1, 132, 2344)

Syntax
DATEVALUE(date)

Parameters
Comment: Date, Type: Text

Examples
DATEVALUE("2/22/2002") returns 37309

Related Functions
TIMEVALUE

8.1.4.8 DAY

The DAY functions returns the day of a date. If no parameter is specified the current day gets
returned.

Return type: Whole number (like 1, 132, 2344)

Syntax
DAY/(date)

Parameters
Comment: Date, Type: Text
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Examples

DAY("2/22/2002") returns 22
Examples

DAY(2323.1285) returns 11

Related Functions

MONTH
YEAR

8.14.9 DAYNAME

The DAYNAME)() function returns the name of the day of the week (1..7). In some countries the
first day of the week is Monday, while in others the first day of the week is Sunday.

Return type: Text

Syntax
DAYNAME(weekday)

Parameters
Comment: Number of day in week (1..7), Type: Whole number (like 1, 132, 2344)

Examples
DAYNAME(1) returns Monday (if the week starts on Monday)

Related Functions
WEEKDAY

8.1.4.10 DAYOFYEAR

The DAYOFYEAR() function returns the number of the day in the year (1...365).
Return type: Whole number (like 1, 132, 2344)

Syntax
DAYOFYEAR(year;month;date)

Parameters

Comment: Year, Type: Whole number (like 1, 132, 2344)
Comment: Month, Type: Whole number (like 1, 132, 2344)
Comment: Day, Type: Whole number (like 1, 132, 2344)

Examples
DAYOFYEAR(2000;12;1) returns 336

Examples
DAYOFYEAR(2000;2;29) returns 60
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8.1.4.11 DAYS

The DAYS() function returns the difference between two dates in days.
Return type: Whole number (like 1, 132, 2344)

Syntax
DAYS(date2; datel)

Parameters

Comment: First (earlier) date value, Type: Text
Comment: Second date value, Type: Text

Examples
DAYS("2002-02-22"; “2002-02-26") returns 4

8.1.4.12 DAYS360

The DAYS360() function returns the number of days from datel to date2 using a 360-day calendar
in which all months are assumed to have 30 days. If method is false (default) the US method will
be used, the European otherwise.

Return type: Whole number (like 1, 132, 2344)

Syntax
DAYS360(datel; date2; method)

Parameters

Comment: Datel, Type: Text
Comment: Date2, Type: Text
Comment: Method, Type: A truth value (TRUE or FALSE)

Examples
DAYS360("2/22/2002"; “4/21/2002"; FALSE) returns 59

Related Functions

DAYS
MONTHS
WEEKS
YEARS

8.1.4.13 DAYSINMONTH

The function DAYSINMONTH() returns the number of days in the given year and month.
Return type: Whole number (like 1, 132, 2344)

Syntax
DAYSINMONTH(year;month)

Parameters

Comment: Year, Type: Whole number (like 1, 132, 2344)
Comment: Month, Type: Whole number (like 1, 132, 2344)

Examples
DAYSINMONTH(2000;2) returns 29
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8.1.4.14 DAYSINYEAR

The function DAYSINYEAR() returns the number of days in the given year.
Return type: Whole number (like 1, 132, 2344)

Syntax
DAYSINYEAR(year)

Parameters
Comment: Year, Type: Whole number (like 1, 132, 2344)

Examples
DAYSINYEAR(2000) returns 366

8.1.4.15 EASTERSUNDAY
The EASTERSUNDAY() function returns the date which corresponds to Easter Sunday in the
year given as the parameter.

Return type: Date

Syntax

EASTERSUNDAY (year)
Parameters

Comment: Year, Type: Whole number (like 1, 132, 2344)
Examples

EASTERSUNDAY (2003) returns "20th April 2003”

8.1.416 EDATE

The EDATE functions returns the date that is specified by a given date and a number of months
before or after that date.

Return type: Date

Syntax
EDATE(date; months)

Parameters

Comment: Date, Type: Text
Comment: Months, Type: Whole number (like 1, 132, 2344)

Examples
EDATE("2/22/2002"; 3) returns “5/22/2002"
Examples

EDATE("3/31/2002"; -1) returns "2/28/2002"

Related Functions

DATE
EOMONTH
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8.1.4.17 EOMONTH

The EOMONTH functions returns the last day in the month specified by a date and the number
of months from that date.

Return type: Date

Syntax
EOMONTH(date; months)

Parameters

Comment: Date, Type: Text
Comment: Months, Type: Whole number (like 1, 132, 2344)

Examples

EOMONTH("2/22/2002"; 3) returns “5/31/2002"
Examples

EOMONTH("3/12/2002"; -1) returns “2/28/2002"

Examples
EOMONTH("3/12/2002"; 0) returns “3/31/2002"

Related Functions

EDATE
MONTH

8.1.4.18 HOUR

The HOUR functions returns the hour of a time. If no parameter is specified the current hour gets
returned.

Return type: Whole number (like 1, 132, 2344)

Syntax
HOUR(time)
Parameters

Comment: Time, Type: Text

Examples
HOUR("22:10:12") returns 22

Examples
HOUR(0.1285) returns 3

Related Functions

MINUTE
SECOND
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8.1.4.19 HOURS

The HOURS() function returns the value of the hours in a time expression.
Return type: Whole number (like 1, 132, 2344)

Syntax
HOURS(time)

Parameters
Comment: Time, Type: Text

Examples
HOURS("10:5:2”) returns 10

8.1.4.20 ISLEAPYEAR

The function ISLEAPYEAR() returns True if the given year is leap.
Return type: A truth value (TRUE or FALSE)

Syntax
ISLEAPYEAR(year)

Parameters
Comment: Year, Type: Whole number (like 1, 132, 2344)

Examples
ISLEAPYEAR(2000) returns True

8.1.4.21 ISOWEEKNUM

The ISOWEEKNUM() function returns number of the week which the date falls into. Note that
this function is compliant with the ISO8601 standard: a week always begins on a Monday, and

ends on a Sunday. The first week of a year is that week which contains the first Thursday of the
year.

Return type: Whole number (like 1, 132, 2344)

Syntax
ISOWEEKNUM(date)

Parameters
Comment: Date, Type: Text

Examples
ISOWEEKNUM(A1) returns 51 when Al is “21st of Dec”.

Related Functions
WEEKNUM
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8.1.4.22 MINUTE

The MINUTE functions returns the minutes of a time. If no parameter is specified the current
minute is returned.

Return type: Whole number (like 1, 132, 2344)

Syntax
MINUTE(time)

Parameters
Comment: Time, Type: Text

Examples

MINUTE("22:10:12") returns 10
Examples

MINUTE(0.1234) returns 57

Related Functions

HOUR
SECOND

8.1.4.23 MINUTES

The MINUTES() function returns the value of the minutes in a time expression.
Return type: Whole number (like 1, 132, 2344)

Syntax
MINUTES(time)

Parameters
Comment: Time, Type: Text

Examples
MINUTES("10:5:2”) returns 5

8.1.4.24 MONTH
The MONTH functions returns the month of a date. If no parameter is specified the current

month gets returned.
Return type: Whole number (like 1, 132, 2344)

Syntax
MONTH(date)

Parameters
Comment: Date, Type: Text

Examples

MONTH("2/22/2002") returns 2
Examples

MONTH(2323.1285) returns 5

Related Functions

DAY
YEAR
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8.1.4.25 MONTHNAME

The MONTHNAME() function returns the name of the month (1...12).
Return type: Text

Syntax
MONTHNAME(number)

Parameters
Comment: Number of month (1..12), Type: Whole number (like 1, 132, 2344)

Examples
MONTHNAME(5) returns May

8.1.4.26 MONTHS

The MONTHS() function returns the difference between two dates in months.The third param-
eter indicates the calculation mode: if the mode is 0, MONTHS() returns the maximal possible
number of months between those days. If the mode is 1, it only returns the number of complete
months in between.

Return type: Whole number (like 1, 132, 2344)

Syntax
MONTHS(date2; datel; mode)

Parameters

Comment: First (earlier) date value, Type: Text

Comment: Second date value, Type: Text

Comment: Calculation mode, Type: Whole number (like 1, 132, 2344)
Examples

MONTHS("2002-01-18"; “2002-02-26"; 0) returns 1, because there is 1 month and 8 days in
between

Examples

MONTHS("2002-01-19”; “2002-02-26"; 1) returns 0, because there is not a whole month in
between, starting at the first day of the month

8.1.4.27 NETWORKDAY
The NETWORKDAY() function returns the number of working days between startdate and end-

date.
Holidays must be one of the following: number = days to add, a single date or an array of dates.

Return type: Whole number (like 1, 132, 2344)

Syntax
NETWORKDAY (start date; end date; holidays)

Parameters

Comment: Start date, Type: Text
Comment: End date, Type: Text
Comment: Holidays, Type: Text
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Examples
NETWORKDAY("01/01/2001";701/08/2001") returns 5 workdays

Examples
NETWORKDAY("01/01/2001";"01/08/2001";2) returns 3 workdays

8.1.4.28 NOW

The NOW() function returns the current date and time. It is identical with CURRENTDATETIME
and provided for compatibility with other applications.

Return type: Date

Syntax
NOW()
Parameters
Examples
NOW() returns “Saturday 13 April 2002 19:12:01"

Related Functions

CURRENTTIME
TODAY

8.1.4.29 SECOND

The SECOND functions returns the seconds of a time. If no parameter is specified the current
second is returned.

Return type: Whole number (like 1, 132, 2344)

Syntax
SECOND(time)

Parameters
Comment: Time, Type: Text

Examples
SECOND("22:10:12") returns 12

Examples
SECOND(0.1234) returns 42

Related Functions

HOUR
MINUTE

90



The Calligra Sheets Handbook

8.1.4.30 SECONDS

The SECONDS() function returns the value of the seconds in a time expression.
Return type: Whole number (like 1, 132, 2344)

Syntax
SECONDS(time)

Parameters
Comment: Time, Type: Text

Examples
SECONDS("10:5:2") returns 2

8.1.4.31 TIME

The TIME() function returns the time formatted with local parameters.

Return type: Text

Syntax
TIME(hours;minutes;seconds)

Paramet